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Preface
Describes this document and the conventions that it uses. 

About this Guide xi

Audience xii

Conventions xii

Related Documentation xiv

Customer Support Services xvi

About this Guide
This guide describes Telewindows, a client application that allows more than one 
user to access a G2 knowledge base (or KB) remotely. The guide provides these 
parts and chapters:

• Part I, Using Stand-Alone Telewindows

– Introduction to Telewindows describes the features of Telewindows.

– Running Telewindows describes how to start and stop Telewindows, 
configure the appearance of the window, and log into and log out of a 
secure G2. 

– Using Telewindows describes how to use Telewindows, which includes a 
standard selection-style user interface with a developer menu bar, a 
multiple document interface (MDI), standard mouse gestures, key 
bindings, and shortcut keys.

– Rerouting Telewindows describes how to connect to a different G2 KB 
while it is running.
xi



• Part II, Using Embedded Telewindows

– Using the Telewindows Netscape Plugin describes how to run 
Telewindows inside a Web browser.

– Using the Telewindows ActiveX Control describes how to run 
Telewindows inside any Microsoft COM-compliant container, such as 
Internet Explorer or Visual Basic.

– Using the WorkspaceView ActiveX Control describes how to display 
workspace views inside any Microsoft COM-compliant container, such as 
Internet Explorer or Visual Basic.

• Part III, Appendix and Glossary

– Appendix A, Launching a Telewindows Process describes how to use 
command-line options to start Telewindows.

– Glossary

Audience
This guide is written for anyone that uses Telewindows. This includes users of 
G2-based applications, who use Telewindows to access the G2 that runs the 
application. This also includes G2 developers, who use Telewindows to access 
and operate the developer’s environment of a G2. 

Conventions
This guide uses the following typographic conventions and conventions for 
defining system procedures.

Typographic

Convention Examples Description 

g2-window, g2-window-1, 
ws-top-level, sys-mod

User-defined and system-defined 
G2 class names, instance names, 
workspace names, and 
module names

history-keeping-spec, temperature User-defined and system-defined 
G2 attribute names

true, 1.234, ok, “Burlington, MA” G2 attribute values and values 
specified or viewed through 
dialogs
xii



Conventions
Note Syntax conventions are fully described in the G2 Reference Manual.

Main Menu > Start

KB Workspace > New Object

create subworkspace

Start Procedure

G2 menu choices and button labels

conclude that the x of y ... Text of G2 procedures, methods, 
functions, formulas, and 
expressions

new-argument User-specified values in 
syntax descriptions

text-string Return values of G2 procedures 
and methods in syntax 
descriptions

File Name, OK, Apply, Cancel, 
General, Edit Scroll Area

GUIDE and native dialog fields, 
button labels, tabs, and titles

File > Save

Properties

GMS and native menu choices

workspace Glossary terms

c:\Program Files\Gensym\ Windows pathnames

/usr/gensym/g2/kbs UNIX pathnames

spreadsh.kb File names

g2 -kb top.kb Operating system commands

public void main()
gsi_start

Java, C and all other external code

Convention Examples Description 
xiii



Procedure Signatures

A procedure signature is a complete syntactic summary of a procedure or 
method. A procedure signature shows values supplied by the user in italics, and 
the value (if any) returned by the procedure underlined. Each value is followed by 
its type:

g2-clone-and-transfer-objects 
(list: class item-list, to-workspace: class kb-workspace, 
delta-x: integer, delta-y: integer) 

-> transferred-items: g2-list

Related Documentation 

G2 Core Technology 

• G2 Bundle Release Notes 

• Getting Started with G2 Tutorials 

• G2 Reference Manual

• G2 Language Reference Card

• G2 Developer’s Guide 

• G2 System Procedures Reference Manual 

• G2 System Procedures Reference Card 

• G2 Class Reference Manual 

• Telewindows User’s Guide 

• G2 Gateway Bridge Developer’s Guide 

G2 Utilities 

• G2 ProTools User’s Guide

• G2 Foundation Resources User’s Guide 

• G2 Menu System User’s Guide 

• G2 XL Spreadsheet User’s Guide 

• G2 Dynamic Displays User’s Guide 

• G2 Developer’s Interface User’s Guide 

• G2 OnLine Documentation Developer’s Guide 

• G2 OnLine Documentation User’s Guide 
xiv



Related Documentation
• G2 GUIDE User’s Guide 

• G2 GUIDE/UIL Procedures Reference Manual 

G2 Developers’ Utilities

• Business Process Management System Users’ Guide

• Business Rules Management System User’s Guide

• G2 Reporting Engine User’s Guide

• G2 Web User’s Guide

• G2 Event and Data Processing User’s Guide

• G2 Run-Time Library User’s Guide

• G2 Event Manager User’s Guide

• G2 Dialog Utility User’s Guide

• G2 Data Source Manager User’s Guide

• G2 Data Point Manager User’s Guide

• G2 Engineering Unit Conversion User’s Guide

• G2 Error Handling Foundation User’s Guide

• G2 Relation Browser User’s Guide

Bridges and External Systems 

• G2 ActiveXLink User’s Guide

• G2 CORBALink User’s Guide

• G2 Database Bridge User’s Guide

• G2-ODBC Bridge Release Notes

• G2-Oracle Bridge Release Notes

• G2-Sybase Bridge Release Notes

• G2 JMail Bridge User’s Guide

• G2 Java Socket Manager User’s Guide

• G2 JMSLink User’s Guide

• G2 OPCLink User’s Guide

• G2 PI Bridge User’s Guide

• G2-SNMP Bridge User’s Guide
xv



• G2 CORBALink User’s Guide

• G2 WebLink User’s Guide

G2 JavaLink

• G2 JavaLink User’s Guide

• G2 DownloadInterfaces User’s Guide

• G2 Bean Builder User’s Guide

G2 Diagnostic Assistant

• GDA User’s Guide 

• GDA Reference Manual

• GDA API Reference

Customer Support Services
You can obtain help with this or any Gensym product from Gensym Customer 
Support. Help is available online, by telephone, by fax, and by email.

To obtain customer support online:

 Access G2 HelpLink at www.gensym-support.com. 

You will be asked to log in to an existing account or create a new account if 
necessary. G2 HelpLink allows you to:

• Register your question with Customer Support by creating an Issue.

• Query, link to, and review existing issues.

• Share issues with other users in your group. 

• Query for Bugs, Suggestions, and Resolutions.

To obtain customer support by telephone, fax, or email:

 Use the following numbers and addresses: 

Americas Europe, Middle-East, Africa (EMEA)

Phone (781) 265-7301 +31-71-5682622

Fax (781) 265-7255 +31-71-5682621

Email service@gensym.com service-ema@gensym.com
xvi
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xvii
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Part I
Using Stand-Alone
Telewindows
Chapter 1: Introduction to Telewindows 

Describes the way Telewindows interoperates with a G2 application, including licencing.

Chapter 2: Running Telewindows 

Shows you how to connect Telewindows to a G2 process.

Chapter 3: Using Telewindows 

Describes how to interact with the standard Telewindows user interface.

Chapter 4: Rerouting Telewindows 

Shows you how to operate the sample knowledge base that demonstrates rerouting 
Telewindows.
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Introduction
to Telewindows
Describes the way Telewindows interoperates with a G2 application, including 
licencing.

Introduction 3

Telewindows Executables 4

Connecting Your Telewindows to a Running G2 5

Displaying the Same KB in Different Windows 5

Displaying the Same Workspace in Different Windows 7

How G2 Manages Communications with Telewindows 10

Telewindows Licensing 12

Introduction
Gensym’s Telewindows product allows you to open a window into a running G2 
process. Opening a window into a G2 means that a Telewindows user can view 
and work with the contents of the knowledge base (KB) that the G2 contains. 

Telewindows and G2 interoperate in a client-server relationship. When you use 
Telewindows to access a G2 KB, the G2 process is the server and your 
Telewindows is its client. 

Each of several Telewindows users with sufficient privileges can independently 
and simultaneously open and close windows into the same G2. In addition, a 
Telewindows-compliant, G2-based application can offer each Telewindows user a 
distinct view of the G2’s KB, that is, a distinct look-and-feel. 
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For instance, a Telewindows-compliant, G2-based application can offer a simple 
partitioning of the KB, where each user can access only certain workspaces in the 
KB. However, a more sophisticated application strategy might use G2’s capability 
to display text to each Telewindows user in a different, G2-supported natural 
language, and at the same time provide different categories of functionality to 
users in different groups. 

Telewindows and G2 do not impose any particular scheme for categorizing users 
of your application. For instance, your application can categorize its users by 
access level or by operational group, or by a combination of the user’s role in an 
organization, point of access, and required application function. 

Tip The techniques required to develop and deliver a Telewindows-compliant, 
G2-based application are described in G2-Windows and Telewindows Support in 
the G2 Reference Manual. 

The Telewindows and G2 client-server combination offers more than a remote 
window into the contents of the application. Combining Telewindows and G2 
provides a powerful client-server platform for running distributed, real-time 
applications over a network. 

Telewindows Executables
Telewindows provides two executables:

• Telewindows Next Generation (twng.exe on Windows only)

Telewindows Next Generation uses a multiple document interface (MDI) in 
which workspaces appear in their own windows. It provides a developer 
menu bar and standard popup menus, which have a different look from 
standard Telewindows. Telewindows Next Generation includes all G2 
functionality. This executable is only available on Windows platforms and 
supports the -ui multiwindow command-line option only.

• Standard Telewindows (tw.exe on Windows and tw on UNIX) 

By default, standard Telewindows uses a single document interface (SDI) in 
which workspaces appear in a single G2 window. You can also run standard 
Telewindows in classic mode, which uses the classic G2 user interface. 
Standard Telewindows includes a subset of G2 functionality. This executable 
is available on Windows and UNIX platforms, and it supports the 
-ui standard and -ui classic command-line options.

For information on the features supported in Telewindows Next Generation only, 
see Telewindows Next Generation Only Features in the G2 Bundle Release Notes.

For details on these command-line options, see ui.
4



Connecting Your Telewindows to a Running G2
Note This guide assumes you are running twng.exe unless otherwise stated. Also, all 
references to “Telewindows” implies twng.exe. 

Telewindows exists as two separate executables to provide maximum 
compatibility with existing applications. 

Connecting Your Telewindows to a Running G2 
You start your Telewindows because you want to connect to a running G2 
process. Your Telewindows must run on a computer that is connected to a 
network via a TCP/IP network protocol. The computer that runs G2 must also be 
connected to the same network in the same manner. 

A running G2 process is one that resides in the computer’s memory and whose 
execution is not currently suspended by the computer’s operating system. It does 
not matter whether the G2’s current KB is running, paused, or reset: the G2 
process itself runs independently of the current KB’s run status. 

Thus, starting Telewindows is an attempt to establish a dynamic connection to a 
G2 process. This dynamic connection uses the physical network connection 
between your computer and the computer running G2. 

After your Telewindows establishes a connection with a G2, the G2 process 
determines what you see in your Telewindows’ window. Each keystroke and 
mouse click that you initiate within the Telewindow is sent to the connected G2. 

The maximum number of TCP/IP network connections to or from a single G2 
process on Windows platforms is 2048. 

Displaying the Same KB in Different Windows 
When you start Telewindows, your computer begins running a Telewindows 
process that displays its own visible window. If the Telewindows has successfully 
connected with a G2 process, all information displayed in the Telewindow is sent 
by that process. 

From the point of view of a G2 process, each Telewindows with which it 
establishes a connection acts as a remote window. A G2 can also have a local 
window, which typically displays on the screen of the computer that runs the G2. 

For a G2 process that has a local window and at least one remote window, each 
window: 

• Can display a distinct set of the KB workspaces of the current KB, each at a 
position and scale that is distinct for this window 

• Has its own Scrapbook workspace 
5



• Has its own Text Editor and Inspect workspaces 

Otherwise, each of a G2’s local and remote windows displays the same instance of 
the Operator Logbook and Message Board, and of everything else contained in 
the G2’s KB. 

This means that two or more Telewindows users connected to the same G2 can 
display any of the G2 KB’s workspaces, and can do so independently of which of 
the KB’s workspaces the other Telewindows users are displaying. 

The figure below shows two workspaces that illustrate the relationship between: 

• A G2 process, running on one computer connected to a network 

• Three Telewindows processes running on different computers connected to 
the same network and each connected to the G2 

The diagram’s top workspace shows: 

• The G2’s local window, which displays its own view of the current KB 

• Each Telewindows’ window, which simultaneously displays its own view of 
the G2’s KB 

In the diagram’s top workspace, note that the display in the windows 
telewindow-1 and telewindow-3 are the same, and the display in telewindow-2 and 
in the G2’s window are the same. This reflects the fact that a G2 can display a 
different set of the current KB’s workspaces in each window that is services. The 
diagram’s bottom workspace represents one of the workspaces contained in the 
G2’s KB.
6



Displaying the Same Workspace in Different Windows
This figure shows is a schematic diagram of a G2’s local and remote windows:

Displaying the Same Workspace in Different 
Windows 

A G2 services both its local window and the remote windows resulting from 
Telewindows connections. If the same KB workspace is visible in more than one 
of those windows, the items upon that workspace appear exactly the same in all: 
the same color, same x, y locations upon the workspace, and so on. Further, G2 
can display a given workspace at a unique location and at a different scale within 
each window that it services. 

To illustrate, the following figures shows the Telwindows client window and the 
G2 server window for the same application. The G2 window shows two 
workspaces found in the G2’s current KB: one that shows a top-level schematic 
representation of a factory floor and another that provides controls. The 
Telewindows window displays only one workspace, the top-level schematic. 

Schematic Diagram of a G2’s Local and Remote Windows 

Network connection

This workspace
contains ...
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For the Telewindows window, notice that: 

• The Telewindows window provides a Windows menu bar and workspace 
view with scroll bars.

• The Telewindows user has changed the size and shape of the Telewindows’ 
window from its default. The user accomplished this using the window’s own 
controls, as provided by the computer’s window manager software. 

• The Telewindows user has used a G2 keystroke command (Control + s) to 
decrease the scale at which the top-level schematic workspace appears in the 
Telewindows’ window. 

In addition, note that when the G2 user or Telewindows user at one window 
updates an item’s knowledge, that change is also visible in the other windows. 

Telewindows 
client window
8



Displaying the Same Workspace in Different Windows
G2 server 
window
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In the next figure, two Telewindows connected to the same G2 display the same 
workspace. 

When the user interacting with the first window performs an operation that 
moves the list object’s icon, that object also appears to move in the second 
window. Thus, two or more Telewindows users connected to the same G2 can 
view the same dynamic state of that G2’s KB. 

How G2 Manages Communications with 
Telewindows 

After your Telewindows establishes a connection with a running G2 process, you 
no longer operate the Telewindows process directly. Rather, all of your 
Telewindows’ behavior is determined by the information it receives from the 
connected G2. Also, your Telewindows forwards each operation (that is, 
keyboard entry or mouse clicks) that you initiate within its window to the 
connected G2. 

Your Telewindows and the connected G2 communicate with each other by 
sending messages to each other. Each message from the G2 to your Telewindows 
directs the Telewindows to update the display in its window. Each message from 
your Telewindows to the connected G2 is the result of a user-initiated operation 
on or within the Telewindows window. 

 Changes to Items on a Displayed Workspace Appear in All Windows 
10



How G2 Manages Communications with Telewindows
Your Telewindows may become unable to receive information from the 
connected G2 as quickly as the G2 sends it. Also, operations you initiate within 
the Telewindows window may not be received by the connected G2 as quickly as 
possible. For example, if the G2 sends many messages to your Telewindows that 
direct it to update the display in its window (such as alternating requests to show 
and hide workspaces every second), the Telewindows may not react to those 
messages as quickly as the G2 requires. 

This can occur when:

• Applications and processes running on your computer require enough 
resources to starve your Telewindows of the computer’s resources

• The network communication link is too slow to pass the information as 
quickly as the G2 requires. 

When a G2 notices that your Telewindows is not accepting the information that 
the G2 is transmitting as quickly as the G2 requires, the G2 stops sending new 
information to the Telewindows. This allows the Telewindows extra time to 
receive and react to the messages that it has already received from the G2, or that 
are in transit across the network. When this situation occurs, the G2 places this 
message on its Operator Logbook: 

After the communication link again becomes clear, the G2 resumes 
communication with your Telewindows and refreshes the contents of the 
Telewindows’ window. When this occurs, the G2 places this message on its 
Operator Logbook: 

When a G2 temporarily suspends its communication with your Telewindows, 
some messages to the Telewindows may be lost. However, because the G2 
automatically refreshes the display in your Telewindows’ window, missing 
messages should not generally be a problem for the Telewindows user. 

If the link between a G2 and your Telewindows regularly becomes overloaded, or 
if your Telewindows’ response to user input is regularly sluggish, notify your 
system administrator. 
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Telewindows Licensing 
Gensym offers two distinct Telewindows license options: 

• Floating 

• Dedicated

Floating Telewindows Licenses

A floating Telewindows license is authorized at run-time by the target G2. You 
can purchase a G2 license that authorizes a certain number of floating 
Telewindows licenses. The G2 authorization file (the g2.ok file) specifies the 
maximum number of floating Telewindows that can connect to it simultaneously. 

After you install the Telewindows product on all computers that access a 
particular G2, that G2 accepts as many concurrent floating Telewindows 
connections as it is licensed to receive. After G2 reaches its limit for concurrent 
floating Telewindows connections, it rejects further connection requests until at 
least one floating license connection becomes available. 

Dedicated Telewindows Licenses

A dedicated Telewindows license provides authorization to use your 
Telewindows product on a particular computer. Each dedicated Telewindows 
license has a particular authorization level—Development or Deployment. 

A Dedicated Telewindows can always connect to any G2, whether or not that G2 
is licensed to receive connections from any floating Telewindows. However, a 
Deployment Telewindows cannot connect to a Development G2. 

For more information about G2 and Telewindows license options, see Licensing 
and Authorization in the G2 Reference Manual. 
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Introduction
You use Telewindows to open a window into a running G2 for either of two 
reasons: 

• You are an end user who wants to interact with a running G2 application.

• You are a developer who wants to access G2’s development environment. 

If you want to open a window on a secure G2, you must also login to that G2. 
Logging in to the G2 means that you supply a user name and password (and 
optionally a user mode, default language, and g2-window), either in the 
command-line that starts your Telewindows or in a login dialog that the G2 
displays. 
13



After you login, the KB’s own restrictions determine which parts of the KB you 
can view and interact with during a Telewindows connection. 

This chapter explains how to:

• Obtain the network address or port name of the G2 server.

• Start Telewindows.

• Configure window properties.

• Log into a secure G2.

• Log out of a secure G2.

• Close a Telewindows process.

For general information on how to interact with the Telewindows interface, see 
Using Telewindows.

Obtaining the Network Address or Port Name of 
the G2 Server

Because a Telewindows user cannot reliably anticipate the network address and 
port name of a particular G2 process on your network, you must obtain this 
information from your G2 system administrator. You need to obtain the name of 
the host computer and the port number.

The general practice for managing multiple G2s running on a group of networked 
computers is for each G2 to use the same port number or port name. For platform-
specific details about configuring your network environment for a G2-based, 
Telewindows-compliant application, refer your network administrator to the 
readme-g2.html file in your G2 installation directory.

By default, a new G2 process running on a computer connected to a network uses 
the TCP/IP port number 1111.

However, the G2 system administrator can start a G2 process so that it uses any 
available port number or port name. 

If you have access to the G2 server, you can obtain the network address by 
choosing Main Menu > Miscellany > Network Info. The table that appears shows 
the host name in the title bar and the port number for the given protocol, for 
example:
14



Starting Telewindows
You can also start G2 with the -netinfo command-line option to display the 
network information in the title bar of the G2 server window. 

On Windows platforms, starting G2 from the Start menu displays the network 
information in the title bar. On Windows platforms, when the G2 server is 
running, an icon appears in the taskbar notification area ( ). The tooltip shows 
the host and port of the G2 server, for example, MY-HOST:host:1111. 

Starting Telewindows 
You start a new Telewindows by executing an operating system command that 
invokes the Telewindows executable image. Telewindows has these default 
executables, depending on the platform: 

For details on the differences between these executables, see Telewindows 
Executables.

If you invoke the Telewindows image from a current directory that is not the 
Telewindows installation directory, you must also specify certain command-line 
options. See Specifying Command-Line Options. 

Each Telewindows that you start is a separate process. Each Telewindows process 
attempts to connect with a G2 process. When connected, it communicates with 
that process exclusively: one Telewindows process does not directly communicate 
with other Telewindows processes. 

Multiple G2s running on the same network can communicate with and interface 
with each other in a distributed manner. Only Telewindows is restricted to 
connecting with one G2 at a time.

For details on command-line options for starting Telewindows, see Appendix A, 
Launching a Telewindows Process. 

Windows: twng.exe and tw.exe

UNIX: tw
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Entering the Command Line 

During its startup, a new Telewindows process attempts to establish a network 
connection with a running G2 process running on the local host at port 1111.

If the G2 server is running on a different host or port, include these two 
arguments in the command that starts Telewindows: 

• The network host name of the computer where the G2 is running. Your 
network administrator assigns network host names to each computer 
connected to your network. 

• The TCP/IP port number that uniquely identifies the G2 process on that 
computer. This port number or port name indicates the network channel on 
which the G2 process listens for connections from other processes. 

Note The host name cannot contain underscores.

To enter the command line:

 In a command window or shell, connect to the g2 directory of your G2 
installation directory and enter the following command, depending on 
your platform:

For example, the following Windows operating system command starts a new 
Telewindows Next Generation process that attempts to establish a network 
connection with the G2 process that is running at TCP/IP port number 1111 on 
the computer whose network host name is central:

twng.exe central 1111 

This command starts a standard Telewindows process on UNIX:

tw central 1111 

Tip You can save the command line that starts your Telewindows session in an alias 
(on UNIX platforms) or in a command file or batch file (on Windows platforms). 

Windows:

install-dir\g2\twng.exe

or

install-dir\g2\tw.exe

UNIX: install-dir/g2/tw
16



Starting Telewindows
Starting Telewindows on Windows Platforms

If you are running Telewindows on a Windows platform, you can start it from the 
Start menu to connect to a G2 process running on the local host at port 1111. You 
can also connect Telewindows directly to the G2 server, running on any port, 
from the icon in the task notification area.

To start Telewindows on Windows platforms:

 Choose Start > Programs > Gensym G2 2015 > Telewindows Next Generation.

or

 Choose Start > Programs > Gensym G2 2015 > Telewindows (Standard).

or

 Mouse right on the G2 icon in the notification area and choose 
Connect Telewindows:

Connect Telewindows locates Telewindows in the registry and automatically 
connects a Telewindows session to the G2 server. If Telewindows Next 
Generation is registered, the Connect Telewindows menu choice uses that. If it 
cannot find Telewindows Next Generation, it uses the registry location of 
Telewindows. 

Telewindows Next Generation and Telewindows are both registered 
automatically when you install the G2 Bundle. However, if G2 cannot find either 
Telewindows for some reason, you can run the -regserver command-line 
option. 

To connect Telewindows instead of Telewindows Next Generation when using 
the Connect Telewindows menu choice, you can run the -unregserver 
command-line option to unregister Telewindows Next Generation. For details, 
see regserver.

Capturing Messages in a Log File 

By default, Telewindows logs all output messages to a log file. The log file is 
saved to a unique name in the directory location of your TEMP environment 
variable. 
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You can also specify your own log file by starting Telewindows with the -log 
command-line option. If you want to see the output messages in the command 
window, start Telewindows with the -no-log option. For details, see Writing 
Standard Output Messages to a Log File.

Establishing a Connection to G2 

A Telewindows and a G2 that run on the same computer can establish a 
connection, and a Telewindows and a G2 that run on different computers and that 
are connected to the same network via the TCP/IP network protocol can also 
establish a connection. 

As a new Telewindows starts up and establishes a connection with the target G2, 
Telewindows generates this message in its default output window or log file: 

If a new Telewindows cannot establish a connection with the specified G2, 
Telewindows generates this message and automatically shuts down. 

After your Telewindows starts and successfully connects to a running G2, if at 
any time the connection between the two is broken before Telewindows shuts 
down, Telewindows generates this message: 

Considering the Compatibility of Telewindows and 
G2 Licenses 

To start Telewindows on your computer, your Telewindows’ license must be 
compatible with the license of the installed G2 product with which you want to 
establish a connection. This compatibility must be part of the design of any G2-
based, Telewindows-compliant application. 

The target G2’s license is compatible only with Telewindows of the same license 
option level or higher. The target G2’s license also determines the maximum 
number of simultaneous Telewindows connections that it can accept. For more 
information, see Licensing and Authorization in the G2 Reference Manual. 

Specifying Command-Line Options 

When you start Telewindows, you can optionally include options in the 
command line. These options allow you, for instance, to pass login information to 
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Configuring Window Properties
a target secure G2, to specify the size and display characteristics of the 
Telewindows window, and to override the timeout interval during which 
Telewindows attempts to connect with the target G2. 

To specify a command-line option, include it in the command that starts 
Telewindows. For example:

twng.exe central 1111 -height 1000 -width 500 -icon Factory 
-name "Factory Productivity Application" 

or

tw central 1111 -height 1000 -width 500 -icon Factory 
-name "Factory Productivity Application" 

This command line starts Telewindows with a window that appears 1000 pixels 
high and 500 pixels wide and that displays the name “Factory Productivity 
Application” in the window’s title bar. Also, when you iconize this Telewindows 
process’s window, the name under the icon displays the word “Factory”. 

For a complete description of the command-line options that Telewindows 
supports, see Appendix A, Launching a Telewindows Process.

Configuring Window Properties
Telewindows displays its window with these default properties: 

• Height in pixels of 90% of the screen’s height in pixels, and width in pixels of 
90% of the screen’s width in pixels 

• Resolution of 75 pixels per inch 

• Magnification of one G2 workspace unit per pixel 

You can initialize these attributes by specifying command-line options when you 
launch a new G2 process or Telewindows process. 

Specifying the Resolution and Magnification 

The -resolution command-line option informs the connected G2 about the 
resolution (in pixels per inch) of the monitor on which the window appears. The 
-magnification command-line option specifies the default magnification at 
which Telewindows’ window displays the connected G2’s KB workspaces at full 
scale. Together, these options determine the absolute size at which Telewindows 
displays a window on a given display device for a given platform. 

By combining the settings of these two options properly, you can launch 
Telewindows on different computers having display devices of different 
resolutions and also display the same KB at the same (or very nearly the same) 
absolute size. Alternatively, by specifying other settings in these options, you can 
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launch a Telewindows that displays a KB at the highest resolution allowed on a 
particular display device. 

For a description of the -resolution and -magnification command-line 
options, see resolution and magnification, respectively. 

For example, if you use this command to launch a Telewindows process: 

twng.exe sitenode 1311 -resolution 75 -magnification 1.0 

or

tw sitenode 1311 -resolution 75 -magnification 1.0 

it is equivalent to this command line: 

twng.exe sitenode 1311 -resolution 100 -magnification 0.75 

or

tw sitenode 1311 -resolution 100 -magnification 0.75 

Tip For best results, consider the dot pitch (that is, the ratio of width to height) of the 
pixels produced on the display devices on your Telewindows platform. 

You can separately initialize either the horizontal or vertical resolution for your 
Telewindows’ window by using the -x-resolution and -y-resolution pair of 
command-line options. See x-resolution and y-resolution for more information 
about these options. 

You can also separately initialize either the horizontal or vertical magnification 
for your Telewindows’ window by using the -x-magnification and 
-y-magnification pair of command-line options. See x-magnification and 
y-magnification for more information about these options. 

Specifying the Window’s Dimensions 

You can initialize the height and width in pixels of your Telewindows’ window 
by using the -height and -width command-line options. For more information 
about these options, see height and width, respectively. 

When you launch a Telewindows process, you can specify the -fullscreen 
command-line option to display its window at full-screen size. 

Logging in to a Secure G2 
If your Telewindows establishes a connection with a secure G2, before the G2 
allows you access to its KB, you must use Telewindows to log in to the G2. 
Logging in to a secure G2 means that you must enter in the G2 login dialog a user 
name and password, and optionally a user mode, g2-window item or class name, 
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Logging in to a Secure G2
and window-specific language. Alternatively, you must provide the same 
information as options in the command line that starts your Telewindows. 

Using the G2 Login Dialog to Login 

After your Telewindows establishes a connection with a running G2 that is 
secure, G2 displays the G2 login dialog. This figure shows the default G2 login 
dialog:

The default values in the fields of the login dialog that your G2-based application 
presents are probably different from those shown in the figure above. This is 
because the application can set the default values of each login dialog field, except 
the Password field. 

The fields in the login dialog have these purposes: 

• User name: Name that is associated with an entry in the secure G2’s 
authorization file, also known as the g2.ok file. 

• Password: Series of characters associated with a user name. 

• G2 user mode: A kind or access, or level of access, to the secure G2’s KB. A 
user can be assigned one or more user modes. 

• G2 window name or class: Name of an item of the g2-window class, or the 
name of a subclass of the g2-window class, or the name of an item whose class 
is a subclass of the g2-window class. 

• G2 window specific language: Name of the natural language in which the 
G2-based application displays the application’s user-interface text, for this 
Telewindows session. 

Entering a User Name, Password, and User Mode 

To respond to the G2 login dialog, you must enter at least the user name and 
password that the system administrator of your G2-based application has 
assigned to you. If the G2 user mode (or alternative user modes) that has been 
assigned to you is different from the default value that appears in the login 
dialog, you must also enter your assigned user mode. To obtain your assigned 
21



user name, password, and user mode (or alternative user modes), speak with the 
system administrator of your G2-based application. 

When you enter your password, your Telewindows does not display the 
password’s characters on your computer’s screen. 

Entering a Window Name or Class Name 

Enter the name of a g2-window item or of a subclass of G2’s g2-window class. If 
you do so, after you login to G2, the application associates your Telewindows 
session with an object in the G2’s KB that is under the application’s control. 

Entering a Window-Specific Language 

Enter the name of one of the alternative natural languages that the application 
supports for displaying the text portions of the application’s user interface. 

If you leave this field’s value as none, then your Telewindows session displays 
the application’s user-interface text in the application’s own default natural 
language. 

Note When connecting Telewindows to a G2 server that is using the Japanese language 
facility, you must install the Japanese-capable Windows fonts. For more 
information, visit www.declan-software.com/japanese_ime/.  

For more information on the natural language facilities available in G2 and 
Telewindows, see Natural Language Facilities in the G2 Reference Manual. 

Correcting a Login 

If the G2 accepts your login, you can access its KB. If not, G2 displays the login 
again, so that you can correct your login information. A secure G2 allows only a 
few additional attempts to correctly login before breaking its connection with 
your Telewindows and shutting it down. 

Using Telewindows Command-Line Options to 
Log In 

If you repeatedly login to a G2-based application that runs on a secure G2, you 
can optionally specify your login information in the command line that starts 
your Telewindows, rather than interact with the G2 login dialog each time. When 
you do so, after your Telewindows establishes a connection with the secure G2, 
the G2 does not present the G2 login dialog. 

The following Telewindows command-line options correspond to the fields in the 
G2 login dialog: 

• -user-name corresponds to the User Name field. 
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Logging Out of a Secure G2
• -password corresponds to the Password field. 

• -user-mode corresponds to the G2 User Mode field. 

• -window corresponds to the G2 Window Name or Class field. 

• -language corresponds to the G2 Window Specific Language field. 

To cause a secure G2 to avoid presenting the login dialog, you must specify valid 
-user-name and -password options in the command that starts Telewindows. 
Specifying the other command-line options is optional. 

For example, this Telewindows command line specifies the user’s user name, 
password, and user mode: 

twng.exe central 1111 -user-name george -password george 
-user-mode supervisor 

or

tw central 1111 -user-name george -password george 
-user-mode supervisor 

To avoid including your password in a command line that is stored in a file, you 
can instead start Telewindows with this command line: 

twng.exe central 1111 -user-name george -user-mode supervisor 

or

tw central 1111 -user-name george -user-mode supervisor 

When your Telewindows passes this login information to the secure G2, the G2 
presents the login dialog, but you must enter only your login password in the 
login dialog’s Password field. The secure G2 automatically sets the values of the 
other login dialog fields from the options included in the command line that 
started your Telewindows. 

For a complete description of each Telewindows command-line option, see 
Appendix A, Launching a Telewindows Process.

Logging Out of a Secure G2 
After you have successfully logged into a secure G2, you can stop using the G2-
based application by disconnecting your Telewindows from the application, as 
described under Closing a Telewindows Connection. However, the application 
might also offer you the option of logging out without breaking the connection, so 
that you can log in again later without restarting Telewindows. 

You can log out from the developer menu bar or from the popup menu for the 
overall Telewindows window.
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For information on the developer menu bar, see Using Telewindows to Interact 
with G2.

To log out of a secure G2:

 Choose File > Log Out from the developer menu bar.

or

 Choose Miscellany > Logout from the popup menu for the overall 
Telewindows window.

When you log out, the G2-based application again displays the G2 login dialog. 
Your Telewindows continues to run, although it is no longer associated with a 
g2-window item in the secure G2’s KB. 

Closing a Telewindows Connection
This section describes the default techniques for closing a Telewindows 
connection. Your KB might also define application-specific techniques for closing 
a Telewindows connection. 

Closing a Telewindows connection logs out of the Telewindows process and 
closes the window. Closing a Telewindows connection does not stop the G2 
process. You can also shut down G2 from Telewindows.

Tip To close a Telewindows connection programmatically, use the g2-system-
command system procedure. For details, see System Commands in User Interface 
Operations in the G2 System Procedures Reference Manual. 

You can close a Telewindows connection from the developer menu bar or from 
the popup menu for the overall Telewindows window.

For information on the developer menu bar, see Using Telewindows to Interact 
with G2.

The following options display a confirmation dialog before closing the 
connection.

To close a Telewindows connection: 

 Choose File > Disconnect from the developer menu bar.

or

 Choose Miscellany > Close Telewindows Connection from the popup menu 
for the overall Telewindows window.
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Closing a Telewindows Connection
The following options exit Telewindows immediately, without confirmation.

 Choose File > Exit from the developer menu bar.

or

 On Windows platforms, click the close button in the upper-right corner of the 
window.

The following options display a confirmation dialog before disconnecting 
Telewindows and shutting down G2. The confirmation dialog indicates whether 
unsaved changes exist in the KB. 

To close a Telewindows connection and shut down G2:

 Ensure that G2 is paused, then choose File > Shut Down G2 from the 
developer menu bar.

or

 Mouse right on the G2 icon in the notification area and choose Shut Down G2:
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Introduction
Telewindows provides a standard user interface for G2 developers and end 
users. The standard user interface is available by running Telewindows on a 
Windows platform and connecting to G2. The standard interface provides various 
standard Windows user-interface controls, including a developer menu bar, 
popup menus, and certain standard dialogs. In addition, workspaces can appear 
in their own window with scrollbars.

The standard user interface is selection-style, whereby menu choices apply to the 
currently selected object. The user interface also uses standard mouse gestures, 
key bindings, and shortcut keys. These features are available in both G2 and 
Telewindows, and on both Windows and UNIX platforms, except where noted. 

For more information, see Appendix C, Mouse Gestures, Key Bindings, and 
Shortcut Keys in the G2 Reference Manual.
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This chapter describes how to:

• Use the standard user interface demo, which demonstrates the Telewindows 
standard Windows user interface.

• Use Telewindows to interact with G2 by using the developer menu bar, 
standard popup menus, and standard dialogs.

• Control the user interface mode to run Telewindows in multiwindow mode, 
standard mode, and classic mode.

Note The term “standard” refers to the user interface that you get when you run 
Telewindows on a Windows platform, and the term “classic” refers to the G2 6.x 
user interface. Unless otherwise specified, the term “Telewindows” refers to 
Telewindows Next Generation (twng.exe).

For information on creating standard user interfaces, see these chapters in the 
G2 Reference Manual:

• Chapter 41, Windows Menus

• Chapter 42, Windows Dialogs

• Chapter 43, Custom Windows Dialogs

• Chapter 44, Windows Views, Panes, and UI Features

Note The maximum number of allowable icons in Telewindows on the Windows XP 
platform is 131000. This limit applies to all native Windows widgets, including 
menus, toolbars, and dialogs.

Standard User Interface Demo
G2 provides a metal milling demonstration that features the Telewindows user 
interface. This demo is only available on Windows platforms.

To run the demo:

 Choose Start > Programs > Gensym G2 2015 > Examples > G2 > Mill Demo.

Background

The Mill knowledge base illustrates several of G2’s powerful capabilities for 
applying expertise in real time and for rapid development. The example was built 
for demonstration purposes only; it should does not represent a fully deployed 
G2 application. 
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Standard User Interface Demo
The scenario is a metal milling operation for manufacturing bolts from metal 
forgings. This application models and simulates the flow of work-in-process raw 
materials as they are processed through various workstations, including 
distribution stations, conveyers, machine tools and surface treatment stations. 
Through the use of G2's object modeling, rules, and procedures, the work-in-
process is efficiently moved through the network of workstations and 
performance metrics for the operation are determined and displayed.

Key G2 Capabilities 

Here are a few of G2's capabilities to explore through the Mill Demonstration:

• Object modeling — G2 expressions understand when objects, such as 
individual workstations in this example, are related to each other, such as via 
graphical connections. Through this understanding, logic can be represented 
that applies generically across networks of connected objects. This capability 
is extremely valuable for modeling complex operational systems. To illustrate 
this power, try cloning all of the equipment in one of the production lines, 
connecting them together, and connecting the group to the discrete-event-
splitter to the left of the Warehouse workspace and then to the finished goods 
warehouse object to the right of the workspace, then restart the application. If 
you have connected everything correctly, the new line should just start 
working. 

• Object-oriented representation — G2 is an object-oriented environment that 
takes full advantage of the reusability of object properties and behaviors. G2's 
objects are graphical, which adds to their ease-of-use. For example, create a 
new machining production line from scratch by opening up the machine 
palette, cloning some machines on the warehouse workspace, then connecting 
them together and to the discrete-event-splitter and to the warehouse object. 
Restart G2 to see the new line producing product. 

• Animation — G2 readily enables animation of objects, such as the movement of 
materials in the Mill demonstration. The Gantt chart is also an example of an 
animation. Each object image can also be animated through manipulation of 
layers and through formulas that dynamically change dimensions. The bolts 
and the drilling stations are examples of this type of animation. The 
animations are valuable to communicate the state of an operation to both end 
users and to application builders. To move the animation from real-time 
mode to simulation mode, change the scheduler mode, in the Timing 
Parameters system table from real time to as fast as possible. 

• Rule- and procedure-based logic — G2's powerful rule and procedural languages 
represent application logic by using an intuitive, structured natural language. 
The language offers a rich set of expressions for reasoning about objects, their 
relationships, and time-based events. This application particularly takes 
advantage of the language's capabilities to represent the coordination logic 
needed to rout the movement of materials through a network of workstations. 
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G2 is often used for these types of applications. To examine samples of the 
rules and procedures in this application, go to the Mill Top Level workspace, 
then navigate to the workspaces for Mill Rules and Formulas and Mill 
Procedures. 

Try experimenting by writing your own simple rules to monitor the milling 
operation. For example, on a new workspace create the following rule:

whenever the total-part-processed of any mfg-equipment receives a value 
and when the total-part-processed of the mfg-equipment > 50000 

then inform the operator for the next 20 seconds that 
"The [the name of the mfg-equipment] has processed [the value of the
total-part-processed of the mfg-equipment ] parts.  Please schedule
preventative maintenance as soon as possible."    

Obviously, this rule is very simple for illustration purposes. However, it 
shows several powerful capabilities of G2 rules including:

– Understandability by non-programmers.

– Working generically across entire object classes, in this case 
any mfg-equipment.

– Understanding time-based events, for example, whenever … receives a 
value…

– Representation of time, for example, for the next 20 seconds.

• Data visualization — G2 has built-in trend charts for visualizing data. For 
example, open the Mill Statistics workspace to see two configured trend 
charts that display the machine capacity utilization, the percent of run time, 
and the percent of nodes on line. Experiment by editing the properties of these 
charts. 

Using Telewindows to Interact with G2
To interact with G2, using a standard user interface, you must run Telewindows 
on a Windows platform; you cannot run G2 stand-alone with a standard user 
interface. 

Once Telewindows is connected to G2, the G2 developer can use the default top-
level menu bar, also known as the developer menu bar, which includes standard 
File, Edit, View, Window, and Help menus. The developer menu bar also 
includes menus for interacting with workspaces, items, and the overall KB, as 
well as a menu of user menu choices.

Telewindows displays the following menus as standard popup menus:

• Item popups, including user menu choices.

• G2 Main Menu.
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Using Telewindows to Interact with G2
• KB Workspace menu.

• Popups on a selected group of items.

Dialogs for file interactions such as Load KB and Save KB are standard Windows 
dialogs, as are a number of message dialogs.

Telewindows uses a standard selection-style user interface, and standard mouse 
gestures, key bindings, and shortcut keys to interact with workspaces, items, and 
selections. Telewindows also uses a multiple document interface (MDI) as its 
default interface, where each KB workspace appears in its own window.

Starting Telewindows

You start Telewindows, using command-line options that connect to a G2 server 
running on a particular host and port. You can log into a secure G2 as a particular 
user, using command-line options. 

For information on starting Telewindows, configuring window properties, 
logging into a secure G2, logging out of a secure G2, and closing a Telewindows 
connection, see Chapter 2, Running Telewindows on page 13.

To start Telewindows:

1 Start G2 on either a UNIX or Windows machine.

2 Start Telewindows on a Windows machine, with command-line options to 
connect to a specific host and port, as needed.
31



You are now running Telewindows:

Interacting with Workspaces

You interact with workspaces, using a standard selection-style user interface, 
whereby menu choices in the menu bar apply to the current selection. You use 
standard popup menus to interact with workspaces. The popup menu associated 
with a workspace is equivalent to the KB Workspace menu in classic G2. 
Workspaces that appear in the window are classic KB workspaces. 

When you create a new workspace, Telewindows centers the workspace in the 
overall window. If the size of the window is smaller than the dimensions of the 
workspace, the workspace is positioned such that it’s title bar is hidden, thus 
requiring you to move the workspace down to see the title bar. 

Developer 
menu bar
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Using Telewindows to Interact with G2
To interact with workspaces:

1 Choose Workspace > New Workspace to create a new workspace.

The workspace appears in its own window:
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2 Choose Workspace > Name to name the workspace. 

The G2 text editor appears in its own window:

The named workspace looks like this:
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Using Telewindows to Interact with G2
3 Create and name another workspace.

The new workspace is now the selected workspace.

4 Move the workspaces so both are visible in the window, using these 
techniques:

• Drag the workspace title bar.

• Right-click the open area of the workspace and drag the workspace.

• Hold down the CTRL key, then drag the open area of the workspace, 
using the left mouse button.

5 Click anywhere in the second workspace or click the title bar to select it.

The second workspace is now selected, as indicated by its blue title bar, and 
the other workspace is now inactive, as indicated by its grey title bar:

6 Choose Workspace > Drop to Bottom to drop the selected workspace to the 
bottom of the stack.

Active 
workspace 
has a blue 
title bar.

Inactive 
workspace 
has a grey 
title bar.
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Showing Workspaces

By default, when you initially show a workspace, it appears in the upper-left 
corner of the window, and the window just fits the workspace. If the workspace 
fits entirely in the overall Telewindows window, then no scrollbars appear. 

This figure shows Telewindows with one workspaces visible where the entire 
contents of the workspace fits within the visible window, so no scrollbars appear:
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Using Telewindows to Interact with G2
If the workspace does not fit entirely in the overall Telewindows window, then 
scrollbars appear. This figure shows a workspace with scrollbars, which is too big 
to fit in the overall window:

Note When viewing workspaces in Telewindows Next Generation, the show action on 
minimized workspace views automatically restores the workspace view if the 
action also lifts the workspace to the top. For example, show ws-1 restores ws-1 if 
the workspace is minimized, but show ws-1. . . preserving workspace layering 
does not. Similarly, entering go to ws-1 in Inspect for a minimized workspace 
view restores the view, but Control + - does not.
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Scaling Workspaces

By default, scaling a workspace (using CTRL+B and CTRL+S, for example) resizes 
the window to just fit the workspace. If the window has no scrollbars initially, 
scaling the workspace pushes the workspace off screen; it does not add scrollbars. 
If the window already has scrollbars, scaling the workspace adjusts the position 
of the scrollbars in the window. 

This figure shows three workspaces at different scales. Ws-1 is reduced in scale, 
and ws-2 is enlarged and partially off screen. Neither of these workspaces had 
scrollbars initially. Ws-3 had scrollbars initially and is enlarged. 
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Using Telewindows to Interact with G2
Resizing Windows

Resizing a window maintains the current scale of the workspace, adding 
scrollbars as needed if the window becomes smaller than the workspace. If the 
window becomes larger than the workspace, a gray area appears around the 
workspace. 

This figure shows the result of resizing two windows. Ws-1 has been resized to be 
smaller than the workspace, which adds scrollbars. Ws-2 has been resized to be 
larger than the workspace, which shows a gray area around the workspace. 

Using the Window Menu

The Window menu provides standard choices for closing individual and all 
windows, showing individual windows by name, and cascading and tiling 
windows. When cascading or tiling windows, scrollbars and a gray area around 
the workspace might appear, depending on the workspace size.
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This figure shows the Window menu and two windows tiled vertically:

Using Standard Key Bindings for Scrolling 
Workspaces

When running Telewindows Next Generation, you can use these standard key 
bindings for scrolling workspaces:

• Press HOME and END to scroll the workspace view to the top-left and 
bottom-left corner.

• Press CTRL+HOME and CTRL+END to scroll the workspace view to the top-
right and bottom-right corner.

• Press PAGE UP and PAGE DOWN to scroll the workspace view up and 
down.

• Press CTRL+PAGE UP and CTRL+PAGE DOWN to scroll the workspace 
view left and right.

• Press the arrow keys to scroll the workspace view in the direction of the 
arrow.
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Creating Items on Workspaces

You create items on workspaces from the Workspace menu or from the popup 
menu for the workspace.

To create items on workspaces:

1 Select a workspace, then choose Workspace > New Definition > 
Class Definition > class-definition:

The Workspace menu includes most of the options available in the 
KB Workspace menu in classic G2. 

Shortcut You can navigate around the menus in the menu bar by using the arrow keys 
and select a menu choice by pressing Return.

2 Click anywhere in the selected workspace to place the class definition on the 
workspace, which is now selected.
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3 Right-click the open area of the other workspace to select it and display its 
popup menu, then choose New Definition > class-definition > class-definition 
to attach the object to the mouse:

The popup menu for a workspace is equivalent to the KB Workspace menu in 
classic G2.

4 Click anywhere in the workspace to place the class definition on the 
workspace. 
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Using Telewindows to Interact with G2
5 Shrink wrap each workspace, using either the popup menu or the Workspace 
menu, then adjust the windows so both are visible.

The window should look something like this:

Interacting with Items

Similar to interacting with workspaces, you interact with items, using a standard 
selection-style user interface, whereby menu choices in the developer menu bar 
apply to the selected item. You can also use popup menus to interact with items. 
The popup menu associated with an item is equivalent to the G2 item menu in 
classic G2. Popups on items include user menu choices defined for the class. The 
User menu in the developer menu bar also includes user-defined menu choices.

For more information on interacting with items, see Appendix C, Mouse 
Gestures, Key Bindings, and Shortcut Keys in the G2 Reference Manual.
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To interact with items:

1 On the first workspace, left-click the item to select it.

A green box around the item indicates selection:

Note You can edit the colors used for primary and secondary selections by editing 
attributes in the Drawing Parameters system table. For more information, see 
Chapter 6, System Tables in the G2 Reference Manual.

Green box around the 
item indicates selection.
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Using Telewindows to Interact with G2
2 With the item selected, choose Item > Clone: 

3 Click anywhere in the workspace to place the cloned item, which is now the 
selected item:

Menu choice 
applies to the 
selected item.
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4 Right-click the class definition on the second workspace to select the 
workspace and display the item popup menu, then choose clone:

The popup menu on an item is equivalent to the item menu in classic G2 and 
includes user menu choices.

Popup menu on an item 
is equivalent to the 
classic G2 item menu.
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Using Telewindows to Interact with G2
5 Click anywhere in the workspace to place the cloned item: 
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6 With the current item selected, choose Item > Table, choose Table from the 
item popup menu, or double-click the item.

The G2 attribute table appears in its own window:

7 Double-click an attribute value in the table to select the cell and display the 
standard text editor for editing the attribute value.

For details, see Editing Text on page 49.

8 Cancel the Text Editor and hide the table.
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Using Telewindows to Interact with G2
Editing Text

Telewindows provides a Windows text editor that:

• Shows line numbers.

• Uses color to indicate procedure syntax, reserved words, and user-defined 
text. 

• Balances statements by highlighting parentheses.

• Supports word completion.

• Displays signatures for G2 procedures and functions.

• Displays text in fixed and proportional fonts.

• Allows zooming in and out to change the font size.

• Provides toolbar buttons for cut, copy, paste, undo, redo, delete, find and 
replace, go to item, save, and exit.

• Supports standard Windows keyboard shortcuts.
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Using the Windows Text Editor

To use the Windows text editor:

 Choose edit on a procedure, method, or rule, or edit an attribute in a table.

For example, here is the Windows text editor for a user-defined procedure. Notice 
that the procedure statements appear in blue, reserved words appear in brown, 
and text strings appear in magenta. Also notice that when the cursor is on the 
parenthesis at the beginning or end of a statement, the corresponding parenthesis 
is also highlighted. The area at the bottom of the editor provides grammar 
prompts for entering code.

Procedure statement

Text string

Balanced 
parentheses

Reserved word

Buttons for 
expanding/
collapsing 
blocks of code

Toolbar

Line numbers
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Using Telewindows to Interact with G2
Here is the result of entering Ctrl+Space with the cursor on the word g2-nms to 
use word completion:

Here is the result of entering Ctrl+Shift+Space with the cursor on the word 
g2-nms-add-choice to display its signature:
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Here is the result of entering Ctrl+F2 to view the text in a fixed as opposed to 
proportional font, then entering Ctrl+- (minus) twice to zoom the view in to use a 
smaller font:

Here is the result of entering Ctrl+F to display a dialog for finding words, with 
options of matching whole words and case:

Using the Classic Text Editor

To use the classic text editor, you must configure an attribute in the Editor 
Parameters system table. 

To use the classic text editor:

 Specify the prefer-native-editor attribute in the Editor Parameters system table 
to be no.
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Using Telewindows to Interact with G2
Using Keyboard Shortcuts

The text editor supports the following standard and G2-specific keyboard 
shortcuts:

Shortcut Description

Shortcuts Specific to G2 Editor

Ctrl+Space Display word completions for the current word.

Ctrl+Shift+Space Display signature for the current G2 procedure 
or function.

Ctrl+Return Accept edits and end session.

Ctrl+F2 Toggle between fixed and proportional fonts.

Ctrl+F Find.

Ctrl+H Replace.

F3 Find again.

F12 Go to item.

Standard Editor Shortcuts

Down Move cursor down one line.

Shift+Down Move cursor down one line selecting text.

Ctrl+Down Scroll down one line without moving the 
cursor.

Up Move cursor up one line.

Shift+Up Move cursor up one line selecting text.

Ctrl+Up Scroll up one line without moving the cursor.

Left Move cursor left one character.

Shift+Left Move cursor left one character selecting text.

Ctrl+Left Move the cursor left one word.

Ctrl+Shift+Left Move the cursor left one word selecting text.

Right Move cursor right one character.

Shift+Right Move cursor right one character selecting text.
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Ctrl+Right Move the cursor right one word.

Ctrl+Shift+Right Move the cursor right one word selecting text.

Ctrl+[ Move cursor up one paragraph, where a new 
paragraph begins after a blank line.

Ctrl+Shift+[ Move cursor up one paragraph selecting text.

Ctrl+] Move cursor down one paragraph, where a new 
paragraph begins after a blank line.

Ctrl+Shift+] Move cursor down one paragraph selecting 
text.

Ctrl+/ Move cursor left to next space, hyphen, 
parenthesis, or other separator.

Ctrl+Shift+/ Move cursor left to next space, hyphen, 
parenthesis, or other separator, selecting text.

Ctrl+\ Move cursor right to next space, hyphen, 
parenthesis, or other separator.

Ctrl+Shift+\ Move cursor right to next space, hyphen, 
parenthesis, or other separator, selecting text.

Home Move the cursor to the beginning of the current 
line.

Shift+Home Move the cursor to the beginning of the current 
line, selecting text.

Ctrl+Home Move cursor to the start of the page.

Ctrl+Shift+Home Move cursor to the start of the page, selecting 
text.

Alt+Home Move cursor to the beginning of the line.

Alt+Shift+Home Move cursor to the beginning of the line, 
selecting text.

End Move the cursor to the end of the current line.

Shift+End Move the cursor to the end of the current line, 
selecting text.

Shortcut Description
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Using Telewindows to Interact with G2
Ctrl+End Move cursor to the end of the page.

Ctrl+Shift+End Move cursor to the end of the page, selecting 
text.

Page Up Move cursor up one page.

Shift+Page Up Move cursor up one page selecting text.

Page Down Move cursor down one page.

Shift+Page Down Move cursor down one page selecting text.

Delete Delete character to the right of the cursor.

Shift+Delete Cut selected text to the clipboard. 

Ctrl+Delete Delete the word to the right of the cursor.

Ctrl+Shift+Delete Delete line to the right of the cursor.

Backspace Delete character to the left of the cursor.

Alt+Backspace Undo last input.

Ctrl+Backspace Delete the word to the left of the cursor.

Ctrl+Shift+Backspace Delete the line to the left of the cursor.

Alt+Backspace Undo last command.

Ctrl+Z Undo last command.

Ctrl+Y Redo last command.

Ctrl+A Select all.

Ctrl+X Cut selected text to the clipboard. 

Ctrl+C Copy from the clipboard.

Ctrl+V Paste from the clipboard.

Insert Toggle insert/overtype mode.

Shift+Insert Paste from the clipboard.

Ctrl+Insert Copy from the clipboard.

Tab Insert a tab character.

Shortcut Description
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Configuring the Grammar Prompts that G2 Displays

You can use the g2-ui-launch-editor system procedure to configure the prompts 
that appear in the text editor, both the classic G2 text editor and the Windows text 
editor available through Telewindows. 

For details, see Editor Operations in Chapter 33, User Interface Operations in the 
G2 System Procedures Reference Manual.

Shift+Tab Move cursor back one tab.

Return Enter a new line character.

Shift+Return Enter a new line character.

Escape If text is selected, cancel current selectio; 
otherwise, display a configrmation dialog for 
cancelling the editor session.

Ctrl+= (equals) Zoom in.

Ctrl+- (minus) Zoom out.

Ctrl+0 Set zoom scale to normal.

Ctrl+L Cut the current line to the clipboard.

Ctrl+Shift+L Delete the current line.

Ctrl+Shift+L Copy the current line to the clipboard.

Ctrl+T Transpose the current line with the line above.

Ctrl+D Duplicate the current line.

Ctrl+U Lowercase the current selection.

Ctrl+Shift+U Uppercase the current selection.

Shortcut Description
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Using Telewindows to Interact with G2
Working with Selections

You use standard mouse gestures to work with selected items, both in 
Telewindows and in G2.

For a complete list, see Appendix C, Mouse Gestures, Key Bindings, and 
Shortcut Keys in the G2 Reference Manual.

To work with selections:

1 Select the first workspace and click in the open area of the workspace to cancel 
the selection.

2 Drag in the open are of the workspace to select multiple items in the rectangle:

3 With both items selected, move the mouse over one of the items and drag to 
move the entire selection.

4 Left click the open area of the workspace to cancel the selection.

5 Press CTRL+A to select all items on the workspace, including the name box.

6 Hold down the SHIFT key and click the name box to toggle it’s membership in 
the selection.

Draw a rectangle 
around items on 
the workspace to 
select multiple 
items.
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7 With just the two class definitions selected, right-click one of the selected 
items to display a popup for interacting with the selection, then choose 
Align > Top to align the items:

The workspace should look something like this:

Right-click a selection to display 
a popup for interacting with all 
items in the selection.
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Using Telewindows to Interact with G2
When three or more items are selected, you can distribute the items horizontally 
or vertically.

Interacting with the KB

You interact with the KB, using the File, Edit, Run, and Tools menus. You can also 
use the G2 Main Menu, which appears as a popup menu in the overall window. 

To interact with the KB:

1 Minimize both workspaces in the window:

2 Click the close buttons on both workspaces to close them.
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3 Choose Tools > Inspect to display the G2 Inspect workspace:
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Using Telewindows to Interact with G2
4 Choose Edit > System Tables to display a cascade menu of G2 system tables:

Access system 
tables from the 
Edit menu.
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5 Choose Run to view the choices for controlling the G2 run state:

Control the G2 run state and 
run options from the Run menu.
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Using Telewindows to Interact with G2
6 Choose File to view the choices for loading, merging, and saving KBs, and 
exiting G2 and Telewindows:

7 Choose Save KB to display the Save dialog:

Load, save, 
and merge 
KBs, using 
the File menu.
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When the KB is modularized, the Save KB dialog has additional options for 
saving specific modules, as follows:
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Using Telewindows to Interact with G2
8 Pause G2, then choose File > Load KB to display the Load dialog, which 
includes G2 load options:
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9 Choose Tools to show additional choices for interacting with the KB, which 
are equivalent to the choices in the Miscellany submenu of the G2 Main Menu 
in the classic user interface: 
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Using Telewindows to Interact with G2
10 Right-click the background of the window to display a popup menu, which is 
equivalent to the G2 Main Menu in classic G2:

Popup on the overall 
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Printing

You can print the G2 window or selected workspace directly to any printer on the 
Telewindows client. You can also print the G2 window to a postscript file on the 
server from the client.

For optimal printing of all international and special Unicode characters, we 
recommend that you install the Arial Unicode MS font, which is distributed with 
all Microsoft Office 2000 products. The name of the font file is arialuni.ttf. If 
this font is not available, G2/TW uses the default system Arial font, which might 
not have optimal character spacing and might be missing some characters.

To print the G2 window:

 Choose File > Print Window.

The standard print dialog appears for choosing a printer and configuring 
printer preferences:

To print the selected workspace:

 Choose File > Print.

To print to a postscript file on the server:

 Choose File > Print to Server.
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Using Telewindows to Interact with G2
Using the Windows Debugger

Telewindows provides a Windows debugger, similar to the text editor, which 
shows procedure source code in a scroll area, line numbers, the procedure stack, 
and local variable bindings. The debugger shows the current line of source code 
being executed with an arrow. It includes the same buttons that appear in the 
dialog in the server dialog during debugging: Disable Debugging, Continue, and 
Pause. 

For example, here is the Windows debugger that results when using the halt 
statement: 

From this point, you can click Continue to continue executing the procedure, 
Pause to pause G2, or Disable Debugging to disable debugging in the Debugging 
Parameters system table. To continue after pausing, choose Main Menu > 
Continue From Breakpoint. 

Local 
variable 
bindings

Halt 
statement 
with line 
number

Indicates 
procedure 
is halted.

Enables 
source 
stepping
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You can enable the Source Stepping option and continue executing the procedure.

You can set a temporary breakpoint by clicking in the column to the right of the 
line number on which you want to set a breakpoint. 

For information on the text editor, see Editing Text on page 49.

Controlling the User Interface Mode
You can use the following command-line options to start Telewindows. These 
options apply only to Telewindows (tw.exe). Telewindows Next Generation 
(twng.exe) only runs in multiwindow mode.

User Interface Mode Description

-ui standard Single document interface mode, where multiple 
workspaces appear in the same G2 window, like G2 
classic, but where various other user interface 
features use the Windows standard, such as selection, 
top menu bar, and popup menus. 

To start Telewindows in standard mode:

• Windows: Choose Start > Programs > 
Gensym 2015 > Telewindows (Standard).

or

• UNIX: Enter tw from a command shell.

The -ui standard command-line option is the 
default for standard Telewindows (tw.exe and tw).

-ui classic Classic G2 user interface with no standard Windows 
user interface features. 

To start Telewindows in classic mode:

• Windows: tw.exe -ui classic

• UNIX: tw -ui classic

The -ui classic command-line option is only 
supported for standard Telewindows (tw.exe and 
tw); it is not supported for Telewindows Next 
Generation (twng.exe).
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4

Rerouting Telewindows
Shows you how to operate the sample knowledge base that demonstrates rerouting 
Telewindows. 

Introduction 71

What twtour.kb Does 72

Setting up twtour.kb 72

Using the Controls Dialog 73

Introduction
Developers can organize a G2-based application so that the Telewindows running 
on the user’s computer provides a front-end interface to one or more running G2s, 
each of which has loaded KBs whose collective knowledge is distributed, perhaps 
using G2-to-G2 data-service techniques. 

G2 can switch, or reroute, a Telewindows connection from itself to another G2. 
That is, the KB loaded in one G2 can pass the information associated with a 
Telewindows connection to another KB loaded in another G2, where a new 
Telewindows connection is attempted. The host names are looked up on the 
Telewindows (client) side, not on the G2 (server) side. 

For information on rerouting Telewindows, see G2-Windows and Telewindows 
Support in the G2 Reference Manual.

The sample knowledge base (or KB) named twtour.kb illustrates how a G2 
application can reroute, or switch, a Telewindows connection. Find twtour.kb in 
the g2\kbs\samples or g2/kbs/samples subdirectory of your G2 installation 
directory, depending on your platform.
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What twtour.kb Does 
The only programmatic operation specifically required to reroute a Telewindows 
connection is the G2 system procedure g2-reroute-window. However, twtour.kb 
uses GUIDE dialogs (developed using the G2 GUIDE product), a history-keeping 
mechanism, and other features to provide a more complete user interface. 

The twtour.kb also provides a go-back-to-previous-window feature, a site map, a 
site system display, a dialog supporting a manual Telewindows connection, and a 
list of current logins accomplished by Telewindows sessions. 

Once twtour.kb initiates a reroute-window operation, it passes a text string to the 
next G2 process. This text string, contained in the g2-window-initial-window-
configuration-string attribute of the reroutable g2-window item, includes 
information about the current G2 process and any other G2 processes this 
Telewindows connection was previously connected to. The twtour.kb also uses 
an encoding scheme to encode more than one individual string into one string, 
and passes the single string to the next G2 process visited by the rerouting 
operation. After the connection is rerouted, the next G2 process decodes the 
string, then uses its contents to build the appropriate dialogs for a particular 
Telewindows user. 

The twtour.kb example includes GUIDE, UIL, and other UIL-related modules, 
which load automatically from their respective modularized KB files. Use GUIDE 
to change or extend the capabilities of twtour.kb. See the G2 GUIDE User’s Guide 
and the G2 GUIDE/UIL Procedures Reference Manual. 

Setting up twtour.kb 
To set up twtour.kb, you must: 

• Save a backup copy of the site-map.txt file under a new name, such as 
site-map.sav . This file is located in the g2\kbs\utils or g2/kbs/utils 
subdirectory of your G2 installation directory.

• Edit the site-map.txt, as described below.

• Start a G2 process on one or more computers, whose network host names and 
network ports are identified in site-map.txt, then load and start twtour.kb 
on each of these G2s.

• Start a Telewindows process that connects to one of the G2s you just started.

You must edit the ASCII file site-map.txt so that it contains the correct 
information for your site. Each line describes a G2 process running on your 
network that a Telewindows user can access via the mechanisms provided in 
twtour.kb. 
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Using the Controls Dialog
Four pieces of information must be specified on each line in the site-map.txt 
file: 

• Network host name for the computer 

• Port number for the G2 process, up to four characters long 

• Connection type (TCP_IP) 

• Description, up to 20 characters long 

A sample layout of this file is: 

1 2 3 4 5 
12345678901234567890123456789012345678901234567890 
----+----+----+----+----+----+----+----+----+----+ 

sdev7 1111 TCP_IP Mfg. Line #1 
sdev9 1112 TCP_IP Assy. Line #2 

Using the Controls Dialog 
The Controls dialog shows the various options that you have for accessing the 
KB’s operations. The Controls dialog displays a button for each of its major 
dialogs and operations: 

• Site map 

• Describe

• Windows 

• Go Back 

• Manual

• History

• Close TW 
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Using the Site Map Dialog 

The twtour.kb example builds the display for the Site Map dialog from the 
contents of the site-map.txt file, which describes each accessible G2 process. 

Each message in the scroll area of the Site Map dialog describes one G2 process on 
your network. The icon in each message indicates the state of the G2 process: 
running, paused, not available, and so on, as follows: 

• A green icon means the G2 process is running and available. 

• A red icon means that the G2’s KB is presently reset. 

• A grayed icon means the G2 process is either not present, or not visible on the 
network. 

The text in each message also provides more detail about the state of that G2 
process. 

To switch to another G2 process, select its message from this list. In a few seconds, 
twtour.kb reroutes your Telewindows connection to the selected G2. 
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Using the Controls Dialog
Using the Describe Dialog 

The Describe dialog displays information about the g2-window item in the 
connected G2’s KB that represents your present Telewindows connection. 

Using the Windows Dialog 

The Windows dialog lists information about each connected Telewindows 
process (that is, represented as a g2-window item in the connected G2’s KB) that 
is logged in to the G2 where your Telewindows is also connected. 

Using the Go Back Operation 

Press the Go Back Operation button to reroute your Telewindows connection to 
the G2 where it was previously connected. If there was no previous G2 
connection, this button appears dimmed. 
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Using the Manual Dialog 

In the Manual dialog you can reroute your Telewindows connection to the 
computer and the network port that you enter, in the Remote Host Machine 
Name and Remote Host G2 Port Number fields, respectively. 

The Manual dialog demonstrates the kinds of information that the connected G2 
requires to reroute the information in a g2-window item to the next G2. 

After the Manual dialog determines that the status of the specified G2 process is 
OK (and the status is displayed in the Manual dialog’s Status box), the Manual 
dialog’s Connect button reroutes your Telewindows connection to that G2. 

Using the History Dialog 

Using the History dialog lists, you can reroute your Telewindows connection to 
another G2 by selecting from a list of the G2s already visited during this 
Telewindows session. Select one of the displayed messages and press the Reroute 
button. 

Using the Close TW Dialog 

The Close TW dialog lets you confirm that you want to end your Telewindows 
connection.
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Part II
Using Embedded
Telewindows
Chapter 5: Using the Telewindows Netscape Plugin 

Describes how to embed Telewindows as a plugin application that you can access from a Web 
page.

Chapter 6: Using the Telewindows ActiveX Control 

Describes how to use the Telewindows ActiveX control.

Chapter 7: Using the WorkspaceView ActiveX Control 

Describes how to use the WorkspaceView ActiveX control.
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Using the Telewindows
Netscape Plugin
Describes how to embed Telewindows as a plugin application that you can access 
from a Web page. 

Introduction 79

Configuring the Netscape Plugin 80

Introduction
You can embed Telewindows as a Netscape plugin on both Windows and UNIX 
platforms, presenting a live Telewindow that is displayed as part of a Web page. 
Once such a Web page is visible, use the embedded Telewindow to accomplish 
any tasks you would otherwise complete through a standard Telewindows 
connection. G2 must already be running to use a Telewindows plugin. 

The plugin logs its output to a unique log file, whose name begins with ntw. The 
plugin creates the log file in the directory declared by the TMPDIR environment 
variable, if it exists; otherwise, it creates it in the /tmp directory.

The Telewindows plugin requires Netscape Navigator Version 4.0 or higher. For 
further information on plugins, refer to your Netscape documentation. 
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Additional Requirements and Issues 

For a Telewindows plugin to operate correctly: 

• The Telewindows process must be able to create TCP/IP connections freely. 
In an Internet environment, certain firewall security restrictions could prevent 
socket connections. 

• The G2 process to which the Telewindows plugin is connecting must be up 
and running to prevent Telewindows from hanging until the connection 
attempt times out. 

Printing Telewindows from Netscape

If you can print through a standard Telewindows connection on your system, you 
can also print when you access an embedded Telewindows on a Web page. 

Note You cannot print the contents of an embedded Telewindows’ window through 
the Netscape print facility. 

Configuring the Netscape Plugin
Use the following instructions to embed Telewindows into Netscape, using the 
nptwplug.dll plugin. The Netscape plugin is installed in the same directory as the 
tw.exe. The Telewindows Netscape plugin runs in Netscape Version 4.x and 6.x.

Note When running Netscape 4, you do not need to copy the nptwplug.dll file to the 
Plugins directory, as specified in the instructions. Instead, you can specify any 
directory to hold plugins by using the NPX_PLUGIN_PATH environment variable; 
however, you should specify a directory that contains only plugins. Note that this 
environment variable is deprecated in Netscape 6.2.

To configure the Netscape plugin for Telewindows:

1 Copy and paste the nptwplug.dll file from the g2 directory of your G2 
product directory to the Plugins directory in your Netscape product directory. 

2 Configure the TW_HOME_FOR_PLUGIN environment variable to point to the 
directory location of the Telewindows executable.

The directory location for a typical installation is:

Windows: c:\Program Files\Gensym\g2-2015\g2\

UNIX: /usr/gensym/g2-2015/g2/
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Configuring the Netscape Plugin
You can specify just a directory or a complete path to the executable itself. In 
either case, the value of the variable must be an absolute path. If you do not 
specify a file name, the environment variable assumes the executable is 
named tw.exe on Windows and tw on UNIX.

If you do not configure this environment variable, the plugin looks for the first 
occurrence of the Telewindows executable in your PATH environment variable.

3 Launch a text editor and enter the following text exactly as written (the file 
format is case sensitive), substituting values for the arguments to the embed 
and tw_cmd_line commands:

<html>
<head>
</head>
<body>
<p>
<H1> Heading here if desired. </h1>
</p>
<hr>
<center>
<embed type=application/x-telewindows width="pixels"
height="pixels" tw_cmd_line="g2-machine-name g2-port-number 
-log filename">
</center>
</body>
</html>

The width and height arguments to the embed command determine the 
dimension of the window that Netscape creates on the page, as well as the 
dimensions of the Telewindows plugin within that page. 

Note For backward compatibility, on Windows platforms, you can specify 
-width and -height command-line arguments to the tw_cmd_line command 
to determine the width of the Telewindows plugin within the page. However, 
this practice is not recommended and has been superseded; the plugin is now 
always the same size as the window. These arguments are not supported on 
UNIX platforms.

Tip Specifying the -log command-line argument is for Windows platforms only 
and prevents the command window from appearing in front of the Web page 
while each embedded Telewindows’ window is launched. 

You can provide any Telewindows command-line options following the 
tw_cmd_line command, for example, -mag 0.5, which displays workspaces 
at half scale. For more information, see Appendix A, Launching a 
Telewindows Process.
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For example, here is a sample embed command, which connects to a G2 
process running on the Windows machine named helpdesk at port 1300:

<embed type=application/x-telewindows width="600" height="400" 
tw_cmd_line="helpdesk 1300 -log c:\temp\twlog.log -mag 0.75>

4 Save the file as an .htm file with whatever name you want, to the directory 
location of the Netscape executable, for example, tw.htm.

5 Launch Netscape and enter “about:plugins” in the Location field to confirm 
the existence and location of the Telewindows plugin named nptwplug.dll.

6 Choose Open Page from the File menu and open the file created in step 4.

The Telewindows should launch. You can make a bookmark for this page.
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6

Using the Telewindows
ActiveX Control
Describes how to use the Telewindows ActiveX control.

Introduction 83

Using the Telewindows ActiveX Control in Internet Explorer 84

Specifying the Location of the Telewindows Executable 86

Properties 87

Methods 90

Sample HTML Pages 90

Sample Visual Basic Form 100

Introduction
You can run the Telewindows ActiveX control inside of any Microsoft 
COM-compliant container, such as Internet Explorer or Visual Basic. 

Note The Telewindows ActiveX control only works with Microsoft Internet Explorer, 
Version 4.0 or higher. We recommend that you use Version 5.5 or higher.

When embedded in a browser, the Telewindows ActiveX control automatically 
registers the control and determines the location of the Telewindows executable. 
When viewed through a browser or any COM-compliant container, the control 
appears as a single window in which you can display multiple workspaces. The 
control uses standard popup menus, a standard selection-style user interface, and 
standard mouse gestures, key bindings, and shortcut keys. 
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Note Unlike Telewindows, the Telewindows ActiveX control does not provide a 
developer menu bar or status bar. Otherwise, the control behaves exactly like 
Telewindows, as described in Using Telewindows.

The control provides properties and methods that allow you to:

• Connect to a G2 running at a particular host and port.

• Set the user mode, user name, and password.

• Provide an initialization string as a command-line argument.

• Specify the window class to use for displaying workspaces.

• Explicitly specify the location of the Telewindows executable, if needed.

• Specify a standard or classic user interface.

• Create the connection.

For example, to run Telewindows in Internet Explorer, you could create an HTML 
page that defines the ActiveX control as an object, sets its properties, then calls a 
method to connect to G2. Once you have written the HTML page, you would start 
G2 on the specified host and port, then open the HTML page to create the 
connection. Similarly, you could embed the Telewindows control within a Visual 
Basic form, then create text boxes for specifying the properties of the control and a 
button that establishes the connection. Once the connection exists, you can run 
Telewindows from within the container, just as you would any normal 
Telewindows. 

Using the Telewindows ActiveX Control in 
Internet Explorer

To use the Telewindows ActiveX control in Internet Explorer, the control must be 
registered. Registration happens automatically the first time you launch an 
HTML file that references the control. 

Gensym provides an HTML file that you can use to register the control initially. 
You can also write your own HTML file that registers the control, using a URL. If 
necessary, you can also register and unregister the control manually.

Caution Depending on your security settings, Microsoft displays a Security Warning 
dialog the first time you display the control in a Browser, which indicates that 
Gensym asserts that the contents are safe. However, because G2 provides the 
ability to spawn any command on the command line, you should only use the 
control to run G2 applications that you know are safe. 
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Using the Telewindows ActiveX Control in Internet Explorer
Registering the Control Initially

Gensym provides an HTML file that automatically registers the ActiveX control. 
This file registers the newest version of the TwControl.cab file from the default 
installation directory.

To use the Telewindows ActiveX control in Internet Explorer:

 Launch the install.html file, which is located in your Telewindows product 
installation directory. 

For a description of this file, see Installing the Telewindows ActiveX Control.

Registering the Control from a URL

Typically, you write your own HTML code that registers the control from the 
internet, from a local intranet, or from a local file system. Here are some examples:

http://www.mycompany.com/plugins/TwControl.cab

ftp://ftp.mycompany.com/plugins/TwControl.cab

c:\Program Files\Gensym\g2-2015\g2\TwControl.cab

..\..\TwControl.bat

TwControl.cab

You refer to the URL or file when specifying the codebase in your Web page, 
which registers the control. For examples, see Sample HTML Pages.

Depending on the security settings in your browser, the following dialog appears 
when you launch the HTML file:

To register the control, click the Yes button. 
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If the control is already registered, Microsoft displays a confirmation dialog 
asking if you want to register the newer version of the control. This confirmation 
only appears when registering the control from the internet or from an intranet; it 
does not appear when registering the control from the local file system.

Note If you have an earlier version of the control registered that you prefer to use, edit 
the version number of the control in the HTML file. For details, see Install.html 
Code.

Registering the Control Manually

If necessary, you can register the control manually, using a batch file. This file 
registers the TwControl.ocx file from the default installation directory.

To register the Telewindows ActiveX control manually:

 Run this file, located in your Telewindows product installation directory:

registerTwControl.bat

Unregistering the Control

If necessary, you can unregister the control manually, using a batch file. You 
might need to do this for testing the registration of the control from a new 
location, such as an FTP site.

To unregister the Telewindows ActiveX control:

1 Close all clients that are currently displaying the control.

2 Run this file, located in your Telewindows product installation directory:

unregisterTwControl.bat

Specifying the Location of the Telewindows 
Executable

The Telewindows ActiveX control automatically creates an entry in the registry 
for the location of the Telewindows executable. You can also specify the location 
of the executable manually, using a property of the control or an environment 
variable. You might need to specify the location if you have moved the 
Telewindows executable to a different location, or if you want to test a different 
version of Telewindows with the control.

The Telewindows ActiveX control works only with Telewindows (tw.exe); it 
does not work with Telewindows Next Generation (twng.exe). 
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Properties
The control looks for the Telewindows executable in these locations, in this order:

1 TwLocation property of the control, described in Properties.

2 TW_HOME_FOR_ACTIVEX environment variable, for example:

c:\Program Files\Gensym\g2-2015\g2\

You can specify just a directory or a complete path to the executable itself.

3 If you are registering the control through a Web page, the directory in which 
the TwControl.cab file is installed. 

4 The following hard-coded path:

c:\Program Files\Gensym\g2-2015\g2\tw.exe

Properties
The Telewindows ActiveX control uses the following properties when the 
ConnectToG2 method is called. Although you can set these properties when 
Telewindows is connected, they have no effect on the current Telewindows 
connection. For example, resetting the port when a connection already exists does 
not reroute the Telewindows connection to the new port. Instead, the new port 
would be used the next time a connection is attempted.

Property Description

InitString The value of the -init-string command-line 
argument to use when launching Telewindows, as 
a string. This argument is assigned to the 
g2-window-initial-window-configuration-string 
attribute of the g2-window item that is created when 
the connection is made. G2 can use this argument, 
as needed, to identify the Telewindows connection. 
For example:

"twcontrol"

See Refresh Behavior.

LaunchBackground The background color of the Telewindows window.
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LaunchHost The host name of the G2 to which to connect, as a 
string, for example:

"myhost"

The host name can also be an IP address, for 
example:

"1.0.0.1"

LaunchPassword The password to use when logging in to G2, as a 
string, for example:

"112760"

LaunchPort The port at which G2 is running, as a string, for 
example:

"1234"

LaunchUi The type of user interface to use, specified as a 
string. The options are:

• standard

• classic

By default, the control uses standard popup menus, 
standard selection behavior, and standard mouse 
gestures, key bindings, and shortcut keys. This 
behavior corresponds to a LaunchUi of standard. 

The classic option uses G2 classic popup menus, 
and classic mouse gestures, key bindings, and 
shortcut keys.

The LaunchUi property has no default value.

LaunchUserMode The user mode to use when logging in to G2, as a 
string, for example:

"user"

LaunchUserName The user name to use when logging in to G2, as a 
string, for example:

"tasha"

Property Description
88



Properties
LaunchWindow The class of window to use for the control, specified 
as a string. The options are:

• g2-window

• Any g2-window subclass defined in the G2 to 
which the control is connecting

By default, the control uses a G2 window, whereby 
multiple workspaces appear in a single window, 
without scrollbars. This behavior corresponds to a 
LaunchWindow of g2-window. 

The LaunchWindow property has no default value.

LogFile The directory location of the log file to use, or 
false, to disable logging, for example:

"c:\Program Files\Gensym\
g2-2015\g2\tw-control-log.txt"

You can specify an absolute or relative path.

Splashtime The minimum number of seconds to display the 
Telewindows splash screen before connecting to 
G2, as an integer. By default, the splash screen 
always appears. To eliminate it, set this property 
to 0.

TwLocation The directory location of tw.exe, the Telewindows 
executable, as a string, for example:

"c:\Program Files\Gensym\
g2-2015\g2\"

You can specify just a directory or a complete path 
to the executable itself.

Note: In some applications, you might need to use a 
backslash as an escape character, for example:

"c:\\Program Files\\Gensym\\
g2-2015\\g2\\"

See Specifying the Location of the Telewindows 
Executable.

Property Description
89



Methods
The ConnectToG2 method establishes a connection to G2 at the network address 
specified by the Host and Port properties.

Visual Basic Syntax

ConnectToG2

Sample HTML Pages
Following are sample HTML pages that display the Telewindows ActiveX 
control. 

The install.html file is located in the g2 directory of your G2 installation 
directory and installs the control from its default location in the g2 directory. This 
is the only HTML file that registers the control. For details, see Registering the 
Control Initially.

The other HTML files are located in the g2\examples\html directory. Once you 
have registered the control, you can launch the sample Web pages, sample.html, 
classic.html, and twloc.html. The sample Web pages require that you are 
running g2\examples\kbs\twcontrol.kb on the local host at port 1111.

Note that these sample pages provide a placeholder for the actual URL that you 
would use to register the control for your application. For details, see Registering 
the Control from a URL.

To run these examples, you must first start G2 on the local machine. 

Sample HTML Page Description

install.html Installs the control from its default 
location and displays it in Internet 
Explorer. See Installing the Telewindows 
ActiveX Control.

sample.html Displays the control, using the default G2 
window. See Using a Default G2 Window.

classic.html Displays the control, using the classic user 
interface. See Using Classic Telewindows.
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Sample HTML Pages
twloc.html Displays the control, specifying the 
location of the Telewindows executable 
explicitly. See Specifying the Telewindows 
Location.

diag-exe.html Provides online help diagnosing problems 
when installing the control.

Sample HTML Page Description
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Installing the Telewindows ActiveX Control

This example shows the result of launching install.html, which registers the 
control from its default installation directory and displays the control in Internet 
Explorer. When the control is connected, it appears as a gray box with a thick 
black border. The control uses the default window type, which is equivalent to 
specifying the LaunchUI property as standard. 
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Sample HTML Pages
Install.html Code

Below is the HTML code that creates the Telewindows control in a Web page and 
connects to a G2 running on the local host at port 1111. 

The elements of the code are:

• CLASSID specifies a unique ID for the control, using the clsid keyword. Your 
HTML file would use the same unique ID as the example:

CLASSID="clsid:EC99E4EE-F5F1-4323-9829-06E9B0AFB934"

• ID identifies the instance of the Telewindows control, using any symbol, in 
this case, WorkstationView. 

• HEIGHT and WIDTH define the number of pixels allocated for the control in the 
page. 

• HSPACE defines the offset from the left side of the page, in pixels, for the 
control. 

• codebase defines the URL of the control for registering on the local machine. 
You can provide a URL to a location on the internet, on your local intranet, or 
on your local file system. For examples, see Registering the Control from a 
URL.

If the control is not already registered, Microsoft locates the control from the 
URL specified in the codebase, then registers and runs it locally. If the control 
cannot be found, it does not run in the Web page. If the control is already 
registered, Microsoft automatically registers the new version of the control.

Your HTML code should refer to the control exactly as it is written in the 
example: 

codebase="TwControl.cab#Version=8,3,128,0"

To use an earlier version, edit the version number in the HTML file.

• SCRIPT LANGUAGE is always VBScript. 

• WorkstationView.LaunchHost, LaunchPort, and LaunchUI set properties of 
the control. 

• WorkstationView.ConnectToG2 establishes the connection to G2 by calling a 
method on the object.
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The portion of the HTML code that registers and launches the control looks 
like this: 

<OBJECT CLASSID="clsid:EC99E4EE-F5F1-4323-9829-06E9B0AFB934"
ID=WorkstationView HEIGHT=500 WIDTH=700 HSPACE=85
codebase="TwControl.cab#Version=8,3,128,0">

</OBJECT>
<br><a href="examples/html/diag-exe.html"><i>If you don't see G2 
running, click here.</i></a>

<SCRIPT LANGUAGE=VBScript>
WorkstationView.LaunchHost = "localhost"
WorkstationView.LaunchPort = "1111"
WorkstationView.LaunchUI = "standard"
WorkstationView.ConnectToG2()
</SCRIPT>
<!-- End TW code -->
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Sample HTML Pages
Using a Default G2 Window

This example shows Telewindows running as a Web page inside of Microsoft 
Internet Explorer. The background of the control is pale-goldenrod, which you 
specify by using LaunchBackground. The figure shows the popup menu for the 
overall window. 
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Sample.html Code

This code provides a placeholder URL for registering the control, which looks like 
this: http://download.example.com/gensym/TwControl.cab#Version=8,0,128,0. 
You would provide your own URL that points to the location of the control in 
your application. The code specifies pale-goldenrod as the background, using 
LaunchBackground. 

<!-- Begin TW code -->
<!-- <text goes here>-->
<OBJECT CLASSID="clsid:EC99E4EE-F5F1-4323-9829-06E9B0AFB934"

ID=WorkstationView HEIGHT=500 WIDTH=700 HSPACE=85
codebase="http://download.example.com/gensym/

TwControl.cab#Version=8,3,128,0">
</OBJECT>
<br><a href="diag-exe.html"><i>If you don't see G2 running, click 
here.</i></a>

<SCRIPT LANGUAGE=VBScript>
WorkstationView.LaunchHost = "localhost"
WorkstationView.LaunchPort = "1111"
WorkstationView.LaunchBackground = "pale-goldenrod"
WorkstationView.ConnectToG2()
</SCRIPT>
<!-- End TW code -->
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Sample HTML Pages
Using Classic Telewindows

This figure shows Telewindows running in a Web page, using its classic user 
interface. Notice that the G2 Main Menu is classic G2. 
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Classic.html Code

This code specifies the LaunchUI property as classic which launches the control, 
using classic Telewindows.

<!-- Begin TW code -->
<!-- <text goes here>-->
<OBJECT CLASSID="clsid:EC99E4EE-F5F1-4323-9829-06E9B0AFB934"

ID=WorkstationView HEIGHT=500 WIDTH=700 HSPACE=85
codebase="http://download.example.com/gensym/

TwControl.cab#Version=8,3,128,0">
</OBJECT>
<br><a href="diag-exe.html"><i>If you don't see G2 running, click 
here.</i></a>

<SCRIPT LANGUAGE=VBScript>
WorkstationView.LaunchHost = "localhost"
WorkstationView.LaunchPort = "1111"
WorkstationView.LaunchBackground = "pale-goldenrod"
WorkstationView.LaunchUI = "classic"
WorkstationView.ConnectToG2()
</SCRIPT>
<!-- End TW code -->
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Sample HTML Pages
Specifying the Telewindows Location

Normally, the control locates the Telewindows executable automatically, as 
described in Specifying the Location of the Telewindows Executable. To specify 
the location explicitly, set the TwLocation property to the directory location of the 
tw.exe file. 

To run this example, you must place a copy of the executable in the location 
specified in the example: c:\tw-2015\tw.exe.

<!-- Begin TW code -->
<!-- <text goes here>-->
<OBJECT CLASSID="clsid:EC99E4EE-F5F1-4323-9829-06E9B0AFB934"

ID=WorkstationView HEIGHT=500 WIDTH=700 HSPACE=85
codebase="http://download.example.com/gensym/

TwControl.cab#Version=8,3,128,0">
</OBJECT>
<br><a href="diag-exe.html"><i>If you don't see G2 running, click 
here.</i></a>

<SCRIPT LANGUAGE=VBScript>
WorkstationView.TwLocation = "c:\tw-2015\tw.exe"
WorkstationView.LaunchBackground = "wheat"
WorkstationView.ConnectToG2()
</SCRIPT>
<!-- End TW code -->

Refresh Behavior

When you refresh the HTML page, the Telewindows control is unloaded and 
reloaded, which creates a new Telewindows process, using the launch properties 
defined in the HTML file. While this behavior is consistent with the way any 
ActiveX control would behave, it may not be desirable. 

You can use the InitString property as a way of showing the same workspaces 
when a Telewindows connection is disconnected and then reestablished. To do 
this, in G2, you would identify the connection by its init string, which G2 assigns 
to the g2-window-initial-window-configuration-string attribute of the g2-window, 
then show the same workspaces when a connection is reestablished, using the 
same init string. 
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Sample Visual Basic Form
This figure shows the Telewindows ActiveX control running inside of a Visual 
Basic form. The form allows you to set the host, port, and UI mode. The Connect 
to G2 button connects the control to the G2 running on the specified host and 
port, which is running \g2\examples\kbs\twcontrol.kb.

Following is a sample Visual Basic form that displays the Telewindows ActiveX 
control. You can access these examples in the g2\examples\vb subdirectory of 
your G2 installation directory:

Sample Files Description

twform.frm
twform.frx
twproj.vbp
twproj.vbw

Displays the control in a Visual Basic 
application. See Sample Visual Basic 
Form.
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Sample Visual Basic Form
Visual Basic Form

Here is the Visual Basic project that places a TwControl control on the form. The 
form provides text boxes for specifying the LaunchHost, LaunchPort, and 
LaunchUi properties. It also provides a button that calls the ConnectToG2 method 
on the control. The figure shows the properties table for the TwControl. G2 must 
be running before you can connect.
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Visual Basic Code

Here is the code for the form, with the Telewindows ActiveX control properties:

Private Sub ConnectButton_Click()
  TwControl1.LaunchUI = UiComboBox.Text
  TwControl1.ConnectToG2
End Sub

Private Sub HostTextBox_Change()
  TwControl1.LaunchHost = HostTextBox
End Sub

Private Sub PortTextBox_Change()
  TwControl1.LaunchPort = PortTextBox
End Sub
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Using the WorkspaceView
ActiveX Control
Describes how to use the WorkspaceView ActiveX control.
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Methods 109
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Sample Visual Basic Form 114
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Introduction
The WorkspaceView ActiveX control allows you to view KB workspaces inside 
Microsoft COM-compliant containers, such as Internet Explorer or Visual Basic. 

Note The WorkspaceView ActiveX control only works with Microsoft Internet Explorer, 
Version 4.0 or higher. We recommend that you use Version 5.5 or higher. 
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The WorkspaceView control connects to the G2 server through a G2Gateway 
ActiveX control, which is available as part of G2 ActiveXLink. Before you can use 
the WorkspaceView control, you must register the G2Com DLL. You must also 
register the control.

Each G2Gateway connection that displays a workspace view starts an embedded 
Telewindows, without a top-level window, and, therefore, consumes a 
Telewindows license. Each G2Gateway can display multiple workspace views. 
You are restricted as to the number of connections you can make, based on the 
number of Telewindows licenses you have. 

The control provides properties and methods that allow you to:

• Connect to a G2Gateway instance.

• Specify the name or UUID of a KB workspace to show in the view.

Registering the G2Com DLL
Because the WorkspaceView control communicates with the G2 server through G2 
ActiveXLink, you must register the G2Com.dll.

To register the G2Com DLL:

 Run this file, located in the activexlink directory of your G2 Bundle 
installation directory:

runme.bat

Registering the Control
If necessary, you can register the control manually, using a batch file. This file 
registers the WorkspaceView.ocx file from the default installation directory.

To register the WorkspaceView control manually:

 Run this file, located in your Telewindows product installation directory:

registerWSV.bat
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Unregistering the Control
Unregistering the Control
If necessary, you can unregister the control manually, using a batch file. You 
might need to do this for testing the registration of the control from a new 
location, such as an FTP site.

To unregister the WorkspaceView control:

1 Close all clients that are currently displaying the control.

2 Run this file, located in your Telewindows product installation directory:

unregisterWSV.bat

Specifying the Location of the Telewindows 
Executable

The WorkspaceView ActiveX control automatically creates an entry in the registry 
for the location of the Telewindows executable. You can also specify the location 
of the executable manually, using a property of the control or an environment 
variable. You might need to specify the location if you have installed 
Telewindows in a directory other than the default, if you have moved the 
Telewindows executable to a different location, or if you want to test a different 
version of Telewindows with the control.

The control looks for the Telewindows executable in these locations, in this order:

1 TwLocation property of the control, described in Properties.

2 TW_HOME_FOR_ACTIVEX environment variable, for example:

c:\Program Files\Gensym\g2-2015\g2\

You can specify just a directory or a complete path to the executable itself.

3 In the Windows registry under this registry key: 

HKEY_LOCAL_MACHINE\SOFTWARE\Gensym\Telewindows\
8.3 Rev 0\installDir

The value for this entry must be a directory, not a complete path to the 
executable itself.

4 The following hard-coded path:

c:\Program Files\Gensym\g2-2015\g2\twng.exe
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Properties
The WorkspaceView ActiveX control defines the following properties:

Property Description

G2Gateway 
As G2Gateway

The G2Gateway control that establishes the 
connection to G2. The value of the property must be 
an instance of G2Gateway. See also the description 
of ConnectToG2Gateway in Methods.

LaunchUserMode The user mode to use when logging in to G2, as a 
string, for example:

"user"

LaunchUserName The user name to use when logging in to G2, as a 
string, for example:

"tasha"

LaunchPassword The password to use when logging in to G2, as a 
string, for example:

"112760"

LaunchWindow The class of window to use for the control, specified 
as a string. The options are:

• g2-window

• Any g2-window subclass defined in the G2 to 
which the control is connecting

By default, the control uses a G2 window, whereby 
multiple workspaces appear in a single window. 
This behavior corresponds to a LaunchWindow of 
g2-window. 

The LaunchWindow property has no default value.
106



Properties
TwLocation As String The directory location of twng.exe, the 
Telewindows executable, as a string, for example:

"c:\Program Files\Gensym\
g2-2015\g2\"

You can specify just a directory or a complete path 
to the executable itself.

Note: In some applications, you might need to use a 
backslash as an escape character, for example:

"c:\\Program Files\\Gensym\\
g2-2015\\g2\\"

See Specifying the Location of the Telewindows 
Executable.

Property Description
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WorkspaceName 
As String

The named KB workspace to show when the 
control connects to the server, specified as a string. 
The workspace appears with its top-left corner in 
the top-left corner of the control. 

You can also use this property to show a workspace 
dynamically after the connection to the server has 
been established. 

If the workspace name is not known or the 
workspace is restricted, no workspace view is 
shown.

Use either WorkspaceName or WorkspaceUUID, but 
not both.

See also the description of ShowWorkspaceWithName 
in Methods.

WorkspaceUUID 
As String

The UUID of the KB workspace to show when the 
control connects to the server, specified as a string. 
The workspace appears with its top-left corner in 
the top-left corner of the control. 

You can also use this property to show a workspace 
dynamically after the connection to the server has 
been established. 

To determine the UUID of a workspace, set the 
show-uuids-in-attribute-tables attribute of the 
Miscellaneous Parameters system table to yes, then 
show the table of the workspace to show, or refer to 
the uuid attribute directly. The UUID is a string 
composed of 32 consecutive hexadecimal digits (0-
9, a-f, A-F) with no internal punctuation except 
hyphens. The UUID is not case sensitive. If the 
UUID is not known or if the workspace is 
restricted, no workspace view is shown.

Use either WorkspaceName or WorkspaceUUID, but 
not both.

See also the description of ShowWorkspaceWithUUID 
in Methods.

Property Description
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Methods
Note The launch properties of the first workspace view to make a connection determine 
the user name, user mode, password, and window to use when making the 
connection. To ensure that certain launch properties are used for all connections, 
specify the same launch properties in all workspace views. 

Note When using the WorkspaceView ActiveX control in a COM application, such as a 
Visual Basic dialog, the workspace view does not repaint when it is dragged 
outside of the visible screen area and then back. The workspace view shows gray 
areas and lines instead of a G2 workspace. To fix this problem, set the 
ClipChildren property to true in the container in which the WorkspaceView 
control appears. 

Methods
The WorkspaceView control supports these methods:

ConnectToG2Gateway G2Gateway

Establishes a connection to G2 through an instance of a G2Gateway control 
and sets the G2Gateway property. 

If multiple workspace views make a call to ConnectToG2Gateway, the first 
workspace view that tries to connect starts Telewindows. Subsequent calls 
to ConnectToG2Gateway use the existing Telewindows.

For information about the G2Gateway control, see the G2 ActiveXLink User’s 
Guide.

ShowWorkspaceWithName WorkspaceName

Shows a named KB workspace in the WorkspaceView control and sets the 
WorkspaceName property. WorkspaceName is a text string that names an 
existing workspace in the connected G2.

ShowWorkspaceWithUUID WorkspaceUUID

Shows a workspace in the WorkspaceView control and sets the 
WorkspaceUUID property. WorkspaceNUUID is a text string that provides 
the UUID of an existing workspace in the connected G2.
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System Procedures
A WorkspaceView control is associated with a GSI interface through its connection 
with G2 ActiveXLink, as well as a G2 window through its connection with 
Telewindows. 

You use the following API procedures to get the G2 window and GSI interface 
associated with the WorkspaceView control. These procedures appear on the 
g2-dialog-api subworkspace of the user-interface-operations-procedures 
workspace of G2 System Procedures.

g2-ui-get-associated-g2-window
(gsi-interface: class gsi-interface)
-> g2-window: class g2-window

Returns the g2-window associated with the gsi-interface for the 
WorkspaceView control.

g2-ui-get-associated-gsi-interface
(g2-window: class g2-window)
-> gsi-interface: class gsi-interface

Returns the gsi-interface associated with the g2-window for the 
WorkspaceView control.
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Sample HTML Page
Sample HTML Page 
This figure shows two workspace views as ActiveX controls inside a web page. 
The HTML page connects to G2 running on the local host at port 1112 through a 
G2Gateway. Each workspace view connects to G2 through the G2Gateway and 
displays a workspace. 

Opening the HTML page creates a connection to Telewindows, which you can 
close by clicking one of the Close TW Connection buttons.

The HTML page requires that the wsvdemo.kb be running on the local G2 on port 
1112. The HTML page is called wsview.html. Both files are located in the g2 
directory of your G2 Bundle installation directory. 
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Notice that the lower workspace view contains scrollbars because the workspace 
is larger than the specified height and width.
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Sample HTML Page
HTML Code

Here is the relevant HTML code with the WorkspaceView control class ID and 
related properties. Gateway1 is the G2Gateway instance, which connects to the G2 
running on the local host at port 1112. 

WorkspaceView1 and WorkspaceView2 are instances of the WorkspaceView 
control, as identified by the unique class ID: 

CLASSID=clsid:AC4C85D0-B16C-11d1-A718-006008C5F933"

WorkspaceView1 sets the WorkspaceName property to the KB workspace named 
ACTIVEX-DEMO-WS. WorkspaceView2 sets the WorkspaceUUID property to the KB 
workspace with the given UUID. 

Each workspace view calls the ConnectToG2Gateway method with Gateway1 as 
the G2Gateway argument.

This HTML code requires that wsvdemo.kb is loaded on the local G2 running on 
port 1112. The HTML code is located in wsview.html. Both files are located in the 
g2 directory of your G2 Bundle installation directory.

<!-- Begin Gensym code -->
<OBJECT CLASSID="clsid:AC4C85D0-B16C-11d1-A718-006008C5F933" 
ID=Gateway1>
</OBJECT>

<OBJECT CLASSID="clsid:A02C8A0F-46E9-450f-B173-FBC85F1F5E91"
ID=WorkstationView1 HEIGHT=300 WIDTH=325 HSPACE=85>

</OBJECT>
<P>
<br>

<OBJECT CLASSID="clsid:A02C8A0F-46E9-450f-B173-FBC85F1F5E91"
ID=WorkstationView2 HEIGHT=650 WIDTH=550 HSPACE=320>

</OBJECT>

<SCRIPT LANGUAGE=VBScript>
Gateway1.G2Location = "localhost:1112"

WorkstationView1.WorkspaceName = "ACTIVEX-DEMO-WS"
WorkstationView2.WorkspaceUUID = 
"98136ed72a6211d68ff80080e9028c67"

WorkstationView1.ConnectToG2Gateway(Gateway1)
WorkstationView2.ConnectToG2Gateway(Gateway1)
</SCRIPT>
<!-- End TW code -->
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Sample Visual Basic Form
This figure shows two WorkspaceView controls running inside of a Visual Basic 
form. The VB form connects to G2 running on the specified host and port through 
a G2Gateway. Each workspace view connects to G2 through the G2Gateway and 
displays a workspace either by name or by UUID.

Displaying the form creates a connection to Telewindows, which you can close by 
clicking one of the Close TW Connection buttons.

To run the VB form requires that wsvdemo.kb be running on the local G2 on port 
1112. The VB project is called WorkspaceViewDemo.vbp and the corresponding 
executable is called WorkspaceViewDemo.exe. All files are located in the g2 
directory of your G2 Bundle installation directory.
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Sample Visual Basic Form
Visual Basic Form

Here is the Visual Basic form that places the WorkspaceView controls on the form. 
The properties of the WorkspaceView control appear in the properties window to 
the right. 

Visual Basic Code

Here is code that establishes the G2Gateway connection for each workspace view 
by setting the G2Gateway property of each workspace view to G2Gateway1. It also 
loads a default workspace for each workspace view by setting the WorkspaceName 
property for each workspace view to the value of the associated text box.

Private Sub Form_Load()
...
GatewayConnection.Text = HostTextBox.Text + ":" + PortTextBox.Text
G2Gateway1.G2Location = GatewayConnection.Text
WorkspaceView1.WorkspaceName = WSNameBox1.Text
WorkspaceView2.WorkspaceName = WSNameBox2.Text
WorkspaceView1.G2Gateway = G2Gateway1
WorkspaceView2.G2Gateway = G2Gateway1
...

End Sub
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Private Sub WSNameBox1_Change()
  If PreferUUID1.Text = "UUID" Then
    WorkspaceView1.WorkspaceUUID = WSNameBox1.Text
  Else
    WorkspaceView1.WorkspaceName = WSNameBox1.Text
  End If
  ConnectWS1.Default = True

End SubPrivate Sub WSNameBox2_Change()
  If PreferUUID2.Text = "UUID" Then
    WorkspaceView2.WorkspaceUUID = WSNameBox2.Text
  Else
    WorkspaceView2.WorkspaceName = WSNameBox2.Text
  End If
  ConnectWS2.Default = True
End Sub

This code sets the WorkspaceUUID or WorkspaceName property of the 
WorkspaceView1 control to the value given in the associated text box:

Private Sub PostMessageBtn_Click()
  G2Gateway1.PostMessage MessageToPost.Text
End Sub

Private Sub WSNameBox1_Change()
  If PreferUUID1.Text = "UUID" Then
    WorkspaceView1.WorkspaceUUID = WSNameBox1.Text
  Else
    WorkspaceView1.WorkspaceName = WSNameBox1.Text
  End If
  ConnectWS1.Default = True
End Sub

This code dynamically shows the workspace specified in the associated text box 
when the user clicks the associated Show Workspace button:

Private Sub ConnectWS1_Click()
  If PreferUUID1.Text = "UUID" Then
     WorkspaceView1.ShowWorkspaceWithUUID WSNameBox1.Text
  Else
     WorkspaceView1.ShowWorkspaceWithName WSNameBox1.Text
  End If
End Sub

Private Sub ConnectWS2_Click()
  If PreferUUID2.Text = "UUID" Then
     WorkspaceView2.ShowWorkspaceWithUUID WSNameBox2.Text
  Else
     WorkspaceView2.ShowWorkspaceWithName WSNameBox2.Text
  End If
End Sub
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Disconnecting from Telewindows
Disconnecting from Telewindows
When a WorkspaceView control shows a workspace by connecting to G2 through 
a G2Gateway, it launches an embedded Telewindows without a top-level window.

You disconnect from Telewindows by shutting down the process that displays 
the workspace view control or by shutting down the server. You can also provide 
a button in your application or web page that disconnects from Telewindows. For 
an example, see Sample HTML Page.

Because Telewindows runs without a top-level window and workspace views can 
contain a single workspace only, other workspaces, such as an attribute table, the 
Text Editor, G2 logbook pages, the Message Board, and Inspect, all appear as top-
level windows in the Windows task bar. You can configure your application so 
that the logbook and message board do not appear when running Telewindows 
without a window.
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For example, to disconnect Telewindows from a G2 Logbook page, choose 
Main Menu > Miscellany > Close Telewindows Connection on the top-level 
logbook page, as follows:
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Introduction 
This appendix contains reference information about starting Telewindows and 
specifying arguments that configure its startup and execution. This information is 
essentially the same for all platforms; minor variations between platforms are 
noted where appropriate. 

Some techniques for starting Telewindows are platform dependent. For details on 
such techniques, see the readme-g2 file and the G2 Bundle Release Notes. Be sure to 
consult these documents if you have any trouble starting.

You can use this information to: 

• Start Telewindows.

• Identify the operating system environment within which executes.

• Specify how utilizes certain of the computer’s resources, such as the initial 
size of memory pools. 
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Starting the Telewindows Process
• Configure execution in various other ways. 

Note In this appendix, the term Windows refers to any version of Microsoft Windows 
on which runs.

Starting the Telewindows Process
You can start a Telewindows process by entering an appropriate operating 
system command, using a command window or any other interface available on 
your platform. The default name of the executable file is:

• Windows: twng.exe (Telewindows Next Generation) or tw.exe 
(Telewindows)

• UNIX: tw (Telewindows)

See the readme-g2.html file for information about platform-dependent 
techniques for starting Telewindows. 

Writing Standard Output Messages to a 
Log File

As a new process starts up, it creates standard output messages, which describe:

• The initial allocations for memory regions.

• Errors encountered while processing an authorization (OK) file.

• Errors that occur while trying to make contact with G2.

A process also displays standard output messages when it must attempt to 
allocate additional memory and when it detects an internal error. The location of 
the messages depends on the platform:

• Under UNIX, standard output messages are displayed in the command 
window from which you launched Telewindows. You can launch 
Telewindows with the -log command-line option to write standard output 
messages to the log file you specify. See log.

• Under Windows platforms, standard output messages are written to a log file. 
You have three options:

– Launch Telewindows with the -log command-line option to write 
standard output messages to the log file you specify. See log.

– Launch Telewindows without the -log command-line option to create a 
uniquely named log file in the directory specified by your TEMP 
environment variable.
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– Launch Telewindows with the -no-log command-line option to write 
standard standard output messages to the command window and not in a 
log file. See no-log.

Using Command-Line Options 
You can include one or more command-line options in the command that starts 
Telewindows. The syntax is:

tw [[hostname] [portname | portnumber] [option]...]

In command-line syntax summaries, brackets [] indicate optional elements, 
braces {} group elements, a vertical bar | separates alternatives, and an ellipsis 
(. . .) indicates zero or more repetitions of the preceding element.

The hostname and portname | portnumber indicate to Telewindows the G2 to which 
it is to connect. If you invoke Telewindows with no arguments, the default values 
are localhost and 1111. These values connect Telewindows to a G2 running at 
the default port number on the same machine as the Telewindows. 

If a hostname and/or a portname | portnumber are specified, they must appear 
before any command-line options. 

Command-line options pass various kinds of information to a new process. 
Regardless of your computer’s operating system, each command-line option must 
begin with the - (hyphen) character, as in this sample command line: 

tw central 1111 -rgn1lmt 7500000 

The command-line options can appear in any order. Some options require or 
allow an argument: a keyword, pathname, expression, or other value that specifies 
the exact meaning of the option.

Note When referring to pathnames with spaces on Windows platforms, you must 
surround the pathname with double quotes, for example, "c:\Program 
Files\Gensym\g2-2015\g2\".  

Supported Command-Line Characters 

When you launch from the command line, interprets the command line as a string 
of 8-bit bytes representing Latin-1 characters. Any two-byte Unicode characters, 
such as Korean or Japanese characters, therefore become pairs of Latin-1 
characters, and the command line is processed accordingly. 
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Dictionary of Command-Line Options
Using Environment Variables

Many command-line options have as counterparts a similarly named 
environment variable. For example, the -v8ok command-line option has a 
counterpart TWV8_OK environment variable. 

If you start processes many times for similar purposes, setting environment 
variables once can be more convenient than specifying the same options in each 
command line. 

Note If you specify a command-line option when its counterpart environment variable 
is already set, the command-line option setting takes precedence. 

Dictionary of Command-Line Options
The rest of this chapter describes all command-line options in alphabetical order. 

The description of each command provides the following sections.

Summary

A brief description of the option, to allow you to determine quickly whether it 
relates to your needs. 

Platforms

The platforms on which the option is available. Most are available on 
all platforms. 

Syntax

The syntax to use when specifying the option on the command line. In command 
line syntax summaries, brackets [] indicate optional elements, braces {} group 
elements, a vertical bar | separates alternatives, and an ellipsis (...) indicates 
zero or more repetitions of the preceding element. 

Equivalent Environment Variable 

You can also specify many options using environment variables. An environment 
variable automatically applies each time you start, obviating the need to specify a 
command-line option. 
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Description 

A detailed description of the option and its effects. 

Special Considerations 

When needed, additional information to keep in mind when using the option. 

Example 

One or more applications of the option in a typical command line. 
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background
background
Changes the gray background of your local Telewindows  window to a solid color 
or to a gray-and-white tiling pattern derived from a GIF or XBM image file you 
specify.

Platforms 

All platforms 

Syntax 

-background { color | file-path | gensym }

color: A symbol that represents a supported G2 color.

file-path: A full pathname to a .gif or .xbm file to use as the background. If the 
pathname contains spaces, surround it with double quotes.

gensym: The G2 “bricks” background, which G2 used as background until 
Version 8.1.

Equivalent Environment Variable 

None

Description 

For a list of supported G2 colors, see ”Identifying the G2 Color Palette” in Chapter 
10 “G2 Items in the G2 Reference Manual.

For information on customizing the background pattern, see ”Customizing the 
Gensym Background Pattern” in Chapter 2 “The Developer’s Environment” in 
the G2 Reference Manual.

The image file must contain no more than 128x128 pixels.

On Windows platforms, you can specify a UNC network path as the file-path, 
such as \\my-server\my-dir\.

Examples

tw sitenode 1311 -background red

tw sitenode 1311 -background 
"c:\Program Files\Gensym\g2-2015\tile.gif"
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closebox
Controls whether the close box in the Telewindows window is enabled 
or disabled. 

Platforms 

Windows

Syntax 

-closebox {enable | disable | default}

Description

When running Telewindows in the standard user interface mode (-ui standard), 
the close box in the upper-right corner of the Telewindows window is enabled. 
When running Telewindows in classic mode (-ui classic), the close box is 
disabled. 

You can use this command-line option to disable or enable the close box, 
depending on the user interface mode. 

The default value is default, which has the behavior described above.
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cjk-language
cjk-language
Directs the new Telewindows process to use your specified Han character-style 
when displaying and printing ideographic, historically Chinese, Han characters.

Platforms 

All platforms 

Syntax 

-cjk-language { chinese | japanese | korean }

Equivalent Environment Variable 

None

Description 

For documentation on the G2 Chinese-Japanese-Korean (CJK) language 
preference, see “Specifying a Han Character-Style Preference” in Chapter 40 
“Natural Language Facilities” in the G2 Reference Manual.

Example

tw sitenode 1311 -cjk-language chinese
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discard-user-settings
Directs Telewindows to discard any user information when it is rerouted.

Platforms

All platforms

Syntax

-discard-user-settings 

Equivalent Environment Variable 

None

Description 

You can specify user information—user name, password, user mode, and 
language—in the Telewindows command line, obviating the need to type it into a 
login dialog. You can also edit the user information in the login dialog. By default, 
Telewindows retains the most recent settings even if it is rerouted, so that the user 
does not have to retype the information.

Specifying -discard-user-settings on the Telewindows command line causes 
Telewindows to discard all user information when it is rerouted, so that you must 
type the user information as required into a login dialog before Telewindows can 
connect to a secure G2.

Example

tw sitenode 1311 -discard-user-settings
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display
display
Directs the new process to display its window on a platform running an 
X Windows server. 

Platforms

UNIX

Syntax 

To route the display to a platform via a TCP/IP network connection: 

-display machine-name:server-number.screen-number 

machine-name: Identifier of a machine running an X Windows server that 
communicates via a TCP/IP network connection.

server-number: Identifier of an X Windows server process on machine-name.

screen-number: Identifier of an X Windows virtual screen managed by X Windows 
server process server-number on machine-name.

Equivalent Environment Variable 

DISPLAY 

The DISPLAY environment variable for most window managers is usually 
configured, by default, to be “local host”, server 0, screen 0. See your X Windows 
documentation for more information. 

Description 

This option allows you to display a process’s window on a specific machine that 
runs an X Windows server, specified by its machine-name. Note that machine-name 
must already be assigned for each machine connecting to a network using 
TCP/IP transport protocol.

If you omit machine-name, the process assumes the local node is the destination. If 
you omit screen-number, it assumes screen 0. 

For more information see your platform’s X Windows reference documentation.
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Example

This command directs the new process to display its window on the X Windows 
server 1, screen 1 running on machine mynode, reached via a TCP/IP network 
connection: 

tw sitenode 1311 -display mynode:1.1 
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do-not-catch-aborts
do-not-catch-aborts
When fetal errors happen, do not catch aborts and let Operating System take over. 

Platforms

All platforms

Syntax 

To stop catching aborts on TW startup: 

-do-not-catch-aborts

Description 

This option will disable all internal error trappings and let Operating System take 
over when fetal errors happen. This option could be useful if user need to 
generate core dumps for sending to G2 support team.
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fonts
Identifies the directory that contains standard font files. 

Platforms 

All platforms 

Syntax 

-fonts fonts-directory-path 

fonts-directory-path: Path, with trailing delimiter character, of a directory that 
contains standard font files. 

Equivalent Environment Variable 

FONTS 

A directory path, with trailing delimiter character. 

Description 

Telewindows includes a set of standard font files. When a new process starts up, 
it expects by default to find the standard font files in a subdirectory named fonts 
under the home directory, that is, the directory where the executable is installed.

Use the -fonts option to direct to look for its standard font files in a custom 
location. 

Special Considerations 

The directory delimiter character to use as a trailing character depends on 
the platform:

• On UNIX platforms, include a trailing / (slash) character.

• On Windows platforms, include a trailing \ (backslash) character. 

On Windows platforms, you can specify a UNC network path as the fonts-
directory-path, such as \\my-server\my-dir\.

Example 

On a Windows platform, this command starts a process and directs it to finds its 
standard font files in the directory c:\fonts\custom-tw\fonts\: 

tw sitenode 1311 -fonts c:\fonts\custom-tw\fonts\ 
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fonts
On a UNIX platform, this command starts a process and directs it to finds its 
standard font files in the directory /usr/kmm/custom-tw/fonts/: 

tw sitenode 1311 -fonts /usr/kmm/custom-tw/fonts/ 
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fullscreen
Directs the new process to display its window so that it is the same size as the 
screen where it displays. 

Platforms 

All platforms 

Syntax 

-fullscreen 

Equivalent Environment Variable 

None 

Description 

If this option is omitted, the new process opens a window that is, by default, 90% 
of the size of the screen. 

In contrast, on a Windows platform, the -screenlock command-line option 
displays window so that it is the same size as the screen and so that it cannot 
appear behind any other open window. See screenlock.

Special Considerations 

Use of the -fullscreen option prevents viewing the window border and its 
selectable components that are managed by your platform’s window manager 
that is, X Windows, DECwindows, or Windows.

Example 

This command starts a process and displays its window so that its extent is the 
same size as the screen where it displays: 

tw sitenode 1311 -fullscreen 
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geometry
geometry
For the window of a new process, specifies the dimensions in pixels and position 
as an offset in pixels from the upper-left corner of the screen. 

Platforms 

All platforms

Syntax 

-geometry widthxheight{+|-}x-offset{+|-}y-offset 

width: Width of the window in pixels. 

height: Height of the window in pixels. 

+x-offset: Pixels from the left of the screen. 

-x-offset: Pixels from the right of the screen. 

+y-offset: Pixels from the top of the screen. 

-y-offset: Pixels from the bottom of the screen. 

Equivalent Environment Variable 

None 

Description 

This option specifies the height and width in pixels of your window, which is 
stored in the g2-window-height and g2-window-width attribute of the g2-window.

On platforms that runs the X Windows window manager, if you omit any values 
in the geometry string, the process takes the missing values from defaults used by 
the X Windows resource manager.

On all platforms, you must provide the widthxheight argument and the x-offset 
and y-offset if you want to specify an offset; otherwise, the offset arguments are 
ignored.

You can also use negative offsets. 

For more information see the X Windows reference documentation for 
your platform. 
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Example

This command launches the Telewindows process with a window that is 800 
pixels wide, 600 pixels high, and is offset from the upper-left corner by 20 pixels 
in each dimension.

tw sitenode 1311 -geometry 800x600+20+20
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height
height
Specifies the height in pixels of the new window. 

Platforms 

All platforms 

Syntax 

-height number-of-pixels 

number-of-pixels: A positive integer from 1 to 32,767

Equivalent Environment Variable 

None 

Description 

This option specifies the height in pixels of your window, which is stored in the 
g2-window-height attribute of the g2-window.

By default, Telewindows displays a window whose height is 90% of the height of 
the screen. 

On Windows platforms, the height refers to the entire window, including the title 
bar and the black frame around the window. On UNIX platforms, the height 
refers to the client window area only; it does not include the height of the title bar 
and window frame.

Example 

This command starts a process with a window whose height in pixels is 1000 and 
whose width in pixels is equivalent to 90% of the width of the screen, the default: 

tw sitenode 1311 -height 1000 
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help
Directs the new process to output text that shows the syntax of all command-line 
options. 

Platforms 

All platforms 

Syntax 

-help 

Equivalent Environment Variable 

None 

Description 

After issuing this command-line option, the process exits. 

Telewindows writes the help text as follows:

• On UNIX platforms, to the launch window.

• Under Windows, to the console window that appears when Telewindows is 
launched, unless the -log command-line option is given, in which case the 
help text is logged to the log file. 

Since the console window disappears when Telewindows exits, you can specify a 
log file to preserve the help text for future use.

Example 

This command directs Telewindows to output text that shows the syntax of all 
command-line options, then exit: 

tw -help 
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icon
icon
Specifies the text that appears below the icon that appears when you iconize the 
new window. 

Platforms 

All platforms 

Syntax 

-icon icon-text 

icon-text: Text of the name of the icon for the process. 

Equivalent Environment Variable 

None 

Description 

When you iconize a window, your platform’s window manager hides the 
window and displays a named icon instead. The -icon option specifies the name 
that appears below that icon. 

The text must conform to the requirements for icon names, in terms of the length 
in characters, the case of alphabetic characters, and so on, established by your 
platform’s window manager. 

Special Considerations 

To embed a blank in icon-text or to specify a mixed case icon-text on a platform 
that does not support commands in mixed-case characters, surround icon-text 
with double quotes, such as: 

g2 -icon "OpAsst" 

Example 

This command starts a new process and causes the text “OPA” to appear below 
the icon whenever you minimize the window: 

tw sitenode 1311 -icon OPA -name "Operator’s Assistant" 

This command also causes the text “Operator’s Assistant” to appear in the title 
bar of the Telewindows window. See name.
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init-string
Passes a text value that assigns into the g2-window-initial-window-configuration-
string attribute of the g2-window item in the connected G2’s KB that is associated 
with this window. 

Platforms 

All platforms 

Syntax 

-init-string init-string-text 

init-string-text: An unquoted, blank-delimited string of characters. 

Equivalent Environment Variable 

None 

Description 

By default, after Telewindows successfully connects to a G2 process, that G2 
process creates a new g2-window item and associates it with the Telewindows 
window. It then assigns the text value specified as the argument to the 
-init-string option to the g2-window-initial-window-configuration-string 
attribute of the new window.

Before assigning the specified text into the g2-window-initial-window-
configuration-string attribute, Telewindows first normalizes the string as a 
symbol. That is, it converts all lowercase characters to uppercase, except for any 
character that follows an @ (at sign) quoting character. 

You can provide user-defined command-line arguments when starting G2, using 
the -init-string command-line option, then use the g2-get-command-line-
arguments-from-launch system procedure to access those user-defined arguments 
in G2. The information is stored in the window object inside G2. For example, you 
can use this argument when displaying Telewindows as an ActiveX control inside 
of a COM-compliant container. For an example, see the Telewindows User’s Guide. 

Example 

This command starts a Telewindows process and attempts to connect to a G2 
process running on the machine whose ID is sitenode via its TCP/IP port 1311. 
The Telewindows process passes to the target G2 the value “Manager”, which G2 
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init-string
assigns to the g2-window-initial-window-configuration-string attribute of the 
Telewindows’ g2-window object in the G2: 

tw sitenode 1311 -init-string Manager 
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language
Specifies a window-specific G2 natural language facility or language-translation 
item for the g2-window item that is associated with the window. 

Platforms 

All platforms 

Syntax 

-language language-name

language-name: Name of a standard G2 language facility—english, japanese, 
korean, or russian—or name of an existing language-translation item—francais, 
italiano, or any other symbol—in the G2 KB. 

Equivalent Environment Variable 

None 

Description 

Each Telewindows connected to a G2 process can specify a distinct window-
specific language. Use the -language option to specify a standard G2 natural 
language facility (english, korean, japanese, or russian) or a language-translation 
item in the G2 KB. This option determines how system-defined menu choices, 
Text Editor buttons, and so on appear in your Telewindows window. 

Using the -language option sets the g2-window-specific-language attribute in the 
g2-window item (in the G2 KB) that is associated with this Telewindows 
connection. Specifying this command-line option is equivalent to specifying the 
G2 Window Specific Language in the login dialog. If you don’t specify the 
-language option, the default value of the g2-window-specific-language attribute 
of this g2-window is none, and the language-translation item used to translate text 
in your window is determined by the current language of the G2 KB.

Example 

This command starts a new Telewindows process that connects to a secure G2, 
specifying a language and other information necessary to connect to the process. 
The command assigns the symbol korean into the g2-window-specific-language 
attribute of the g2-window associated with your Telewindows window: 

tw sitenode 1311 -window viper -user-name howard 
-password fearnoevil -user-mode manager -language korean
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language
The result is that your window displays the text of G2 system-defined menu 
choices, and so on, based on the language-translation item named korean found 
in the G2 KB. 
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local-window
Explicitly starts G2 with a local window. 

Platforms 

All platforms

Syntax 

-local-window

Equivalent Environment Variable 

None

Description 

Currently, this command-line option is redundant, because G2 starts with a local 
window, by default. However, in a future release, G2 will start without a 
window, by default. Therefore, we recommend that you explicitly add this option 
to your startup scripts now if you want G2 to start with a local window, so that in 
the future, you will not have to change your scripts. 
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log
log 
Specifies a particular pathname to which standard output messages should 
be written.

Platforms 

All platforms

Syntax 

-log log-file-path 

log-file-path: Location and name of a file to which the new process writes 
standard output messages.

Equivalent Environment Variable 

None

Description 

If the specified log-file-path names an existing file, Telewindows overwrites the 
existing file. Telewindows does not append version information to user-defined 
log file names. 

On Windows platforms, in the absence of the -log command-line option, 
Telewindows creates a uniquely named log file in the directory specified by your 
TEMP environment variable. The log file name consists of these components:

productname-date-unique-id.log

For example, for a log file created on January 1, 2002, which is the fifth log file 
generated during the Telewindows session, Telewindows would use this file 
name:

%PATH%\TW-000101-5.log

To avoid writing a log file on Windows platforms, use the -no-log command-line 
option. See no-log. This is the default on UNIX platforms.

On Windows platforms, you can specify a UNC network path as the log-file-path, 
such as \\my-server\my-dir\.
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Example 

This command starts a new process and routes its standard output messages to 
the file c:\tw\logs\TW-000410-4.log: 

tw sitenode 1311 -log c:\tw\logs\G2-000410-4.log 
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magnification
magnification 
Specifies the new process’s default ratio of magnification, that is, pixels per G2 
workspace unit, for workspaces displayed at full scale. 

Platforms 

All platforms 

Syntax 

-mag[nification] magnification-ratio 

magnification-ratio: A decimal value from 0.50 to 2.66. 

Equivalent Environment Variable 

None 

Description 

If you specify neither the -magnification option nor the -x-magnification or 
-y-magnification options, the new process uses a -magnification setting of 1.0. 
For more information about using the -magnification, -x-magnification, and 
-y-magnification options, see the Specifying the Resolution and Magnification.

Special Considerations 

Alternatively, for a display device that supports distinct settings for horizontal 
and vertical resolutions, you can use the -x-magnification and 
-y-magnification command-line options to specify distinct horizontal and 
vertical magnifications. However, don’t combine the -magnification argument 
with either the -x-magnification or -y-magnification options. See 
x-magnification and y-magnification.

Example 

This command starts a process that displays workspaces at full scale at the 
magnification of two pixels per G2 workspace unit: 

tw sitenode 1311 -magnification 2.0 
147



minimize
Controls whether the minimize box in the Telewindows window is enabled 
or disabled. 

Platforms 

Windows

Syntax 

-minimize {enable | disable}

Description

You can use this command-line option to disable or enable the minimize box. 

The default value is enable, which has the normal behavior.
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print-menu-on-custom-dialog
print-menu-on-custom-dialog
Controls whether a “Print...” right-click menu appears on TWNG custom dialog.

Platforms 

Windows

Syntax 

-print-menu-on-custom-dialog

Description

You can use this command-line option to enable the print menu for TWNG 
custom dialog. By default it’s disabled, as in G2 8.3r1.
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name
Specifies the text that appears in the title bar of the new Telewindows window. 

Platforms 

All platforms 

Syntax 

-name window-title-text 

window-title-text: A string of characters; must conform to the requirements of 
your platform’s window manager for title bar text. 

Equivalent Environment Variable 

None 

Description 

The location, appearance, allowable characters, and allowable length of the title 
text are determined by the requirements of your platform’s window manager. 

Special Considerations 

To use this option with Japanese, use 8-bit characters; 16-bit characters do not 
display correctly.

To embed a blank in window-title-text or to specify a mixed case window-title-text 
on a platform that does not support commands in mixed case characters, 
surround window-title-text with double quotes, such as: 

g2 -name "Operator’s Assistant" 

Example 

This command starts a new process and specifies the text “Operator’s Assistant” 
to appear in the title bar of its window: 

tw sitenode 1311 -name "Operator’s Assistant" -icon OPA 

This command also causes the text “OPA” to appear below the process’s icon, 
when it is minimized. 
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network
network
Specifies the network transport protocol that Telewindows uses to connect to a G2 
process. 

Platforms 

All platforms 

Syntax 

-network { tcpip } 

tcpip: Listen for network connections that use the TCP/IP transport protocol. 

Equivalent Environment Variable 

None 

Description 
The -network option should appear no more than once on a Telewindows 
command line, since Telewindows establishes only one connection to its G2. 

Example 

This command starts a new Telewindows process that attempts to connect to the 
G2 process running on the computer whose network host name is sitenode at 
TCP/IP port 1311: 

tw sitenode 1311 -network tcpip 
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no-backing-store
Disables the use of the default backing-store facility.

Platforms 

 UNIX

Syntax 

-no-backing-store 

Equivalent Environment Variable 

None 

Description 

Using an X-Server Backing-Store

By default, with backing-store in effect, the X-server caches a window image in its 
own memory each time a window is obscured or iconized. Then, whenever a 
window, or part thereof, is redrawn, the X-server simply redraws the window 
from memory, rather than requesting an update from the G2 server. 

The advantage of this facility is for Telewindows users, especially those 
connecting to G2 across a slow network. Using this default option precludes the 
need for a Telewindows client to make G2 redraw requests each time a window, 
or any portion of a window, must be redrawn after being iconized or obscured in 
any way. Caching the window on the X-server in such an environment can then 
significantly improve window redraw performance. 

Two disadvantages exist when using the backing-store option: 

• The X-server may require more memory. 

• If the server stops responding, redrawn windows may not be current. 

X-Server Memory Requirements 

The X-server can potentially require more memory when using the backing-store 
feature. The amount of memory required depends on: 

• The size of the window being cached 

• The number of colors in use

If the X-server has sufficient memory when you start G2 or Telewindows, it uses 
what is available to cache the window. If more memory is required for backing-
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no-backing-store
store, the X-server allocates whatever it needs. Additionally allocated memory for 
backing-store then remains in use for the duration of the G2 or 
Telewindows process. 

Updating Cached Windows 

Using backing-store does not affect regular window updates from the G2 server. 
For example, G2 continually updates display items, such as readout-tables and 
trend-charts, even if a window is obscured. Thus, when the X-server redraws a 
window containing display items, its data is always current. 

An obscured or iconized window can potentially become out of date if the G2 
server stops responding to the client. In this case, with backing-store in effect, the 
X-server redraws the window from its previous state, even if that state is no 
longer current. Conversely, if backing-store is not in use (G2 was launched with 
the -no-backing-store command-line option), attempting to redraw an 
obscured window results in an entirely blank window that remains until the G2 
server responds once more. 

Example 

This command starts a new process and disables the use of the backing-
store facility: 

tw -no-backing-store 
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no-log 
Specifies that Windows should not write a log file for the Telewindows process.

Platforms 

Windows

Syntax 

-no-log

Equivalent Environment Variable 

G2_NO_LOG 

Description 

By default, if you launch Telewindows without the -log command-line option, 
Windows creates a uniquely named log file in the TEMP directory, as described in 
Writing Standard Output Messages to a Log File.

The only way to avoid generating a log file is to use the -no-log option.

G2 accepts the G2_NO_LOG environment variable, which causes G2 not to generate 
a log file, as if you had started G2 with the -no-log command-line option. To use 
the variable, set it to a value of 1. 

Example 

This command starts a new Telewindows process with no log file:

tw sitenode 1311 -no-log
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ok
ok
Specifies the location of the Telewindows authorization file. 

Platforms 

All platforms 

Syntax 

-ok ok-file-path 

ok-file-path: Location and name of the authorization file; you can specify a file 
with any name and location. 

Equivalent Environment Variable 

TW_OK 

Same as ok-file-path. 

Description 

The default name of the authorization file is tw.ok. 

If the file TNOCMD.OK is stored in the root directory, Telewindows checks whether 
the authorization file name specified by ok-file-path is listed in TNOCMD.OK. 
Telewindows loads the file only if it is listed there. The root directory is the 
directory / on UNIX platforms or the directory \ on Windows platforms.

If you omit the -ok option, the new process looks for the authorization file in the 
directory from which you launched Telewindows. 

On Windows platforms, you can specify a UNC network path as the ok-file-path, 
such as \\my-server\my-dir\.

Special Considerations 

You can also use the -v11ok command-line option, the TWV11_OK environment 
variable, and the twv11.ok file to specify the location of the authorization file. The 
order of precedence for identifying the authorization file to use is:

1 The -v11ok command-line option.

2 The -ok command line arg.

3 The TWV11_OK environment variable.

4 The G2_OK environment variable.
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5 A file named twv11.ok in the G2 home directory.

6 A file named g2.ok in the G2 home directory.

For more information, see v11ok.

Example 

On a Windows platform, this command starts a new process and identifies 
c:\Program Files\Gensym\g2-2015\g2\my.ok as the authorization file: 

tw sitenode 1311 -ok "c:\Program Files\Gensym\g2-2015\g2\my.ok"

On a UNIX platform, this command starts a new process and identifies 
/usr/gensym/g2-2015/g2/my.ok as the authorization file: 

tw sitenode 1311 -ok /usr/gensym/g2-2015/g2/my.ok 
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password
password
Specifies the password for logging into a secure G2 process. 

Platforms 

All platforms 

Syntax 

-password password-string 

password-string: A series of characters that constitute a password. 

Equivalent Environment Variable 

None 

Description 

Specifying the -password option corresponds to filling in the Password field in 
the login dialog. 

Special Considerations 

When you use the -password option, Telewindows transmits the password string 
as is to the target G2 process. Be sure to consider your risk in transmitting your 
application password in an unencrypted manner. 

Example 

This command starts a new Telewindows process that connects to a secure G2, 
specifying a password and other information necessary to connect to the process: 

tw sitenode 1311 -window viper -user-name howard 
-password fearnoevil -user-mode manager -language korean
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private-colormap
Causes Telewindows to request a dedicated colormap from the X server. The 
default is to use the standard colormap, which is shared by all applications.

Platforms 

 UNIX

Syntax 

-private-colormap 

Equivalent Environment Variable 

None 

Description 

Although most color X workstations are capable of displaying many more than 
256 colors, most X servers can represent only 256 colors at a time. What those 
colors are depends on the applications that access the X server and sometimes on 
the order in which they are run.

When an application wants to display a pixel in a certain color, it asks the X server 
to map the color to an index in the colormap. If the color is not already present in 
the colormap, the X server adds it, using up one more slot in the colormap. If this 
continues, the colormap becomes full. When an application asks for a new 
mapping and the colormap is full, the X server responds by using the closest 
available color to the one requested. The result may not be an acceptable color.

Applications, such as Web browsers, which display images (GIFs, JPEGs, and so 
on) typically need many colors, increasing the chance that the colormap will 
become full. For example, if you run Netscape on your UNIX machine before 
running Telewindows, there is a chance that Telewindows will not be able to find 
space in the colormap for even its 64 basic colors, and the display will look wrong. 

The alternative is to use a private colormap. When a private colormap is in use, no 
other applications can fill up the slots. In the case of Telewindows, this guarantees 
that the 64 basic colors will always be available.

An additional benefit to using a private colormap is that more color cells will be 
available should Telewindows need them. In fact, Telewindows does need them 
to display GIFs well. If you change the image-palette attribute in the Color 
Parameters system table to Custom colors from my-image-def, Telewindows 
displays the GIF rendered better than it has been able to before under X.
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private-colormap
Special Considerations 

The disadvantage of using a private colormap is that the X server has to actively 
switch between color maps. It does this based on focus. If Telewindows is using a 
private colormap and some other application has the focus, the colors in 
Telewindows will appear obviously wrong. When Telewindows is given focus, 
the X server installs its colormap, and the Telewindows window looks fine. 
However, the colors of all other applications, as well as icons and other items 
drawn by the X server and the window manager, will be wrong. They are still 
using the same indices into the colormap as they were before, but those indices no 
longer make sense because a different colormap is in use.

Since users may find this color change problem disconcerting, the -private-
colormap flag is off by default. 

Note This option will be ignored if you are using 24-bit display because the colormap 
would be too large.

Example 

This command starts a new process and requests a private colormap from the 
X server: 

tw -private-colormap 
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regserver
Registers Telewindows.

Platforms 

Windows

Syntax 

-regserver

Equivalent Environment Variable 

None

Description 

When you install the G2 Bundle, Telewindows automatically calls -regserver to 
register both Telewindows Next Generation (twng.exe) and Telewindows 
(tw.exe). 

Telewindows looks in the registry when connecting to G2, as follows:

To use Telewindows instead of Telewindows Next Generation when using the 
Connect Telewindows menu choice, unregister Telewindows Next Generation. 
See unregserver.

The command-line option supports an optional argument, -s, to suppress the 
dialog that appears when you successfully register Telewindows. 

Note You can specify the command-line option by using -regserver and -s, or you 
can use the Windows style command-line options, /regserver and /s.

When connecting... Telewindows connects...

Using the Connect Telewindows 
menu choice on the G2 server icon

Telewindows Next Generation, if it can 
find it in the registry; otherwise, 
Telewindows

Telewindows ActiveX control Telewindows

WorkspaceView ActiveX control Telewindows Next Generation
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regserver
Telewindows writes its location is these Windows registry keys, depending on 
the executable:

The location in the registry for both keys is:

HKEY_LOCAL_MACHINE\SOFTWARE\Gensym\Telewindows\version

where version is the Telewindows version and revision, including Beta, if 
appropriate. For example, the location for Telewindows Version 2015 Rev. 0 is:

HKEY_LOCAL_MACHINE\SOFTWARE\Gensym\Telewindows\8.3 Rev. 0

Executable Registry Key

twng.exe installDir

tw.exe installDirClassic
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resolution
Specifies the resolution of the monitor on which the Telewindows 
window appears. 

Platforms 

All platforms 

Syntax 

-resolution dots-per-inch 

dots-per-inch: An integer in the range 36 to 200. 

Equivalent Environment Variable 

None 

Description 

This option specifies the resolution, in pixels per inch, at which the new process 
displays its window. Use this option to adjust the absolute size of window to the 
resolution characteristics of your display device. For more information see 
Specifying the Resolution and Magnification. 

By default, displays its window at 75 dots per inch (dpi). 

Special Considerations 

For a display device that supports distinct settings for its vertical (y-axis) 
resolution and horizontal (x-axis) resolution, you can specify separate default 
vertical and horizontal resolutions, as follows: 

tw sitenode 1311 -x-resolution 75 -y-resolution 100 

Do not combine the -resolution option with either the -x-resolution or 
-y-resolution options. If you specify the -x-resolution option, you should 
also specify the -y-resolution option, and vice versa. See x-resolution and 
y-resolution.

Example 

This command starts a new Telewindows process that displays its window at a 
resolution of 150 dots per inch: 

tw sitenode 1311 -resolution 150 
162



rgn1lmt
rgn1lmt
Specifies the initial supply of available memory for data other than symbols and 
graphics images. 

Platforms 

All platforms 

Syntax 

-rgn1lmt number-of-bytes 

number-of-bytes: The integer 800000 or higher, up to the maximum per-process 
allocation determined by your platform’s operating system settings. 

Note Do not include commas when specifying number-of-bytes. 

Equivalent Environment Variable 

G2RGN1LMT 

Same syntax as number-of-bytes.

Description 

Telewindows maintains its supply of available memory in three regions. This 
option controls the initial supply of available memory in its Region 1 memory 
pool. Telewindows uses its Region 1 memory pool to store all data other than 
symbols and graphics images. 

The new process allocates Region 1 memory when it is launched. Telewindows 
standard output messages at startup indicate the memory allocation.

The default amount of Region 1 memory is 1,400,000 bytes. 

Special Considerations 

If your -rgn1lmt option specifies less than the minimum number of bytes, 
Telewindows displays a warning standard output message and supplies the 
minimum amount. 

For information about G2 memory management, see the chapter on memory 
management in the G2 Reference Manual. 
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Example 

This command starts a new process and directs it to allocate 1,200,000 bytes as its 
initial supply of Region 1 memory: 

tw sitenode 1300 -rgn1lmt 1200000 

Telewindows attempts to allocate more Region 1 memory as is required by the 
connected G2’s processing. 
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rgn2lmt
rgn2lmt
Specifies the initial supply of available memory for symbol data.

Platforms 

All platforms 

Syntax 

-rgn2lmt number-of-bytes 

number-of-bytes: The integer 800000 or higher, up to the maximum per-process 
allocation determined by your platform’s operating system settings. 

Note Do not include commas when specifying number-of-bytes. 

Equivalent Environment Variable 

G2RGN2LMT 

Same syntax as number-of-bytes. 

Description 

Telewindows maintains its supply of available memory in three regions. This 
option controls the initial supply of available memory in its Region 2 memory 
pool. Telewindows uses its Region 2 memory pool to store symbols and related 
internal data. 

The new process allocates Region 2 memory when it is launched. Telewindows 
standard output messages at startup indicate the memory allocation. 

The default amount of Region 2 memory is 800,000 bytes. 

Special Considerations 

If your -rgn2lmt option specifies less than the minimum number of bytes, 
Telewindows displays a warning standard output message and Telewindows 
supplies the minimum amount. 

For information about G2 memory management, see the chapter on memory 
management in the G2 Reference Manual. 
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Example 

This command starts a new process and directs it to allocate 900,000 bytes as its 
initial supply of Region 2 memory: 

tw sitenode 1311 -rgn2lmt 900000 

Telewindows attempts to allocate more Region 2 memory as is required by the 
connected G2’s processing. 
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rgn3lmt
Specifies the maximum memory used by to render the background images 
of workspaces. 

Platforms 

All platforms 

Syntax 

-rgn3lmt number-of-bytes 

number-of-bytes: The integer 400000 or higher, up to the number of bytes of 
memory actually available to the target platform’s window manager. 

Note Do not include commas when specifying number-of-bytes. 

Equivalent Environment Variable 

G2RGN3LMT 

Same syntax as number-of-bytes. 

Description 

Telewindows maintains its supply of available memory in three regions. This 
option controls the maximum memory that a new process can allocate for its 
Region 3 memory pool. Telewindows uses its Region 3 memory pool to manage 
the graphics image data that displays as the background images of workspaces 
and icons. 

The new process does not allocate Region 3 memory when it is launched. Instead, 
Telewindows allocates Region 3 memory at the time that the connected G2 must 
display a background image. 

The default maximum amount of Region 3 memory is 2,500,000 bytes. If you 
specify a number-of-bytes larger than 2,500,000 bytes, the new process can manage 
more precomputed image renderings, which, in turn, means that background 
images can display more quickly. 

Special Considerations 

If your -rgn3lmt option specifies less than the allowable minimum (400,000), 
Telewindows displays a warning standard output message and substitutes the 
minimum specification. 
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For information about G2 memory management, see the chapter on memory 
management in the G2 Reference Manual. 

Example 

This command starts a new process and restricts it to allocating at most 500,000 
bytes of Region 3 memory: 

tw sitenode 1311 -rgn3lmt 500000 

Telewindows attempts to allocate Region 3 memory as is required by the 
connected G2’s processing. 
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screenlock
Displays the new window so that it occupies the entire screen. 

Platforms 

Windows

Syntax 

-screenlock 

Equivalent Environment Variable 

None 

Description 

On Windows platforms, this option displays the new window at the top of the 
window hierarchy and prevents any other application window from being 
on top.

In contrast, on any supported platform, the -fullscreen command-line option 
displays the window so that it is the same size as the screen and so that the 
window can appear behind any other open window. 

Example 

This command starts a new process and directs it to display its window so that its 
extent occupies the entire screen: 

tw sitenode 1311 -screenlock 

After executing this command, the user also cannot cause any other application’s 
window to appear on top of the window that displays. 
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secure
Encrypts communication.

Platforms 

All platforms

Syntax 

-secure

Equivalent Environment Variable 

None

Description 

This command-line option causes G2 and Telewindows to use SSL on all 
TCP/ICP connections. G2 uses SSPI on Windows and OpenSSL on UNIX.

When the connection is encrypted, the padlock icon appears in the status bar.
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splashtime
Specifies the number of seconds Telewindows should display the splash screen 
before it displays the Telewindows window while connecting to G2.

Platforms 

All platforms 

Syntax 

-splashtime seconds 

seconds: A positive integer from 0 to 30. 

Equivalent Environment Variable 

None 

Description 

A value of 0 seconds specifies that Telewindows should not delay the display of 
its window. Non-zero values specify the number of seconds to delay before 
displaying the Telewindows window during which time it displays the splash 
screen.

Example 

This command starts a new Telewindows process and waits 10 seconds before 
displaying the Telewindows window:

tw sitenode 1111 -splashtime 10 
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tcptimeout
Specifies the time interval during which the new Telewindows process attempts 
to make a TCP/IP network connection to the target G2 process. 

Platforms 

All platforms 

Syntax 

-tcptimeout interval-in-milliseconds 

interval-in-milliseconds: A positive integer from 1 to 20,000. 

Equivalent Environment Variable 

None 

Description 

This option specifies the time interval during which the new Telewindows 
process attempts to make a TCP/IP network connection to the target G2 process. 
If Telewindows cannot make a connection after that interval, Telewindows writes 
an error message to standard output and exits. 

By default, Telewindows attempts to make a connection for one-half second 
(500 milliseconds). You can specify an interval as high as 20 seconds (that is, 
20,000 milliseconds). 

Specify the interval-in-milliseconds without punctuation, such as commas 
or periods. 

Example 

This commands starts a new Telewindows process that attempts to make a 
TCP/IP network connection with the G2 process on the computer whose network 
host name is sitenode at port 1311 for as long as 5 seconds (5000 milliseconds): 

tw sitenode 1311 -tcptimeout 5000 
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ui
Specifies the user interface style when starting Telewindows.

Platforms 

All platforms

Syntax 

-ui standard | classic

Equivalent Environment Variable 

None 

Description 

The -ui standard command-line option runs Telewindows with a single 
document interface (SDI). This option is available on Windows for tw.exe and on 
UNIX for tw. Twng.exe does not support -ui standard. Standard UI mode is the 
default for tw.exe on Windows and tw on UNIX.

Both options provide a standard user interface, where “standard” implies the 
Windows standard, which includes standard selection-style, mouse gestures, 
keystrokes, and key bindings. On Windows platforms, the standard user interface 
also includes a top-level menu bar, called the developer menu bar, standard 
popup menus, and standard file, print, and notification dialogs. On UNIX 
platforms, you get as many native features as the platform supports.

For backward compatibility, you can also run Telewindows with its classic user 
interface, where “classic” implies G2 6.x behavior. The classic user interface uses a 
single document interface (SDI), and classic G2 selection-style, menus, and mouse 
gestures, keystrokes, and key bindings. On Windows platforms, the classic user 
interface does not include a developer menu bar. 

This table summarizes which command-line options are supported for which 
Telewindows executables on which platforms, where the asterisk (*) indicates 
the default:

-ui
twng.exe 

(Windows)
tw.exe 

(Windows)
tw 

(UNIX)

standard no yes* yes*

classic no yes yes
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For a description of the differences between the two Telewindows executables, 
see Telewindows Executables.

Examples 

On Windows platforms, to start Telewindows Next Generation, use this 
command:

twng

To start standard Telewindows with its default user interface, use this command:

tw

Starting Telewindows with no command line options is equivalent to:

tw -ui standard

To start Telewindows with its classic user interface:

tw -ui classic
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unregserver
Unregisters Telewindows.

Platforms 

Windows

Syntax 

-unregserver

Equivalent Environment Variable 

None

Description 

When you install the G2 Bundle, Telewindows automatically calls -regserver to 
register both Telewindows Next Generation (twng.exe) and Telewindows 
(tw.exe). See regserver.

Telewindows looks in the registry when connecting to G2, as follows:

To use Telewindows instead of Telewindows Next Generation when using the 
Connect Telewindows menu choice, unregister Telewindows Next Generation. 

The command-line option supports an optional argument, -s, to suppress the 
dialog that appears when you successfully unregister Telewindows. 

Note You can specify the command-line option by using -unregserver and -s, or you 
can use the Windows style command-line options, /unregserver and /s.

When connecting... Telewindows connects...

Using the Connect Telewindows 
menu choice on the G2 server icon

Telewindows Next Generation, if it can 
find it in the registry; otherwise, 
Telewindows

Telewindows ActiveX control Telewindows

WorkspaceView ActiveX control Telewindows Next Generation
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Telewindows writes its location is these Windows registry keys, depending on 
the executable:

The location in the registry for both keys is:

HKEY_LOCAL_MACHINE\SOFTWARE\Gensym\Telewindows\version

where version is the Telewindows version and revision, including Beta, if 
appropriate. For example, the location for Telewindows Version 2015 Rev. 0 is:

HKEY_LOCAL_MACHINE\SOFTWARE\Gensym\Telewindows\8.3 Rev. 0

Executable Registry Key

twng.exe installDir

tw.exe installDirClassic
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user-mode
user-mode
Specifies the user mode for logging into a secure G2 process. 

Platforms 

All platforms 

Syntax 

-user-mode user-mode-string 

user-mode-string: Series of characters that names a user mode.

Equivalent Environment Variable 

None 

Description 

Specifying the -user-mode option corresponds to filling in the User Mode field in 
the login dialog and sets the g2-user-mode attribute of the current g2-window.

Example 

This command starts a new Telewindows process that connects to a secure G2, 
specifying a user mode and other information necessary to connect to the process: 

tw sitenode 1311 -window viper -user-name howard 
-password fearnoevil -user-mode manager -language korean
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user-name
Specifies the user name under which to log into a secure G2 process. 

Platforms 

All platforms 

Syntax 

-user-name user-name-string 

user-name-string: A user name defined in the authorization file for the target G2. 

Equivalent Environment Variable 

None 

Description 

Specifying the -user-name option corresponds to filling in the User Name field in 
the login dialog and sets the g2-user-name attribute of the current g2-window.

Example 

This command starts a new Telewindows process that connects to a secure G2, 
specifying a user name and other information necessary to connect to the process: 

tw sitenode 1311 -window viper -user-name howard 
-password fearnoevil -user-mode manager -language korean
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v11ok
v11ok
Specifies a custom location for an authorization file that is specific to G2  
Version 2015.

Platforms 

All platforms 

Syntax 

-v11ok v11-ok-file-path 

v11-ok-file-path: Location and name of the authorization file for Version 2015; you 
can specify a file with any name and location. 

Equivalent Environment Variable 

TWV11_OK 

Same syntax as v11-ok-file-path. 

Description 

Like the -ok option, the -v11ok option specifies the path of an authorization file 
for this process. 

Specifying the -v11ok option allows the site manager to configure a system 
environment so that processes launched using a previous version authorize using 
an authorization file for that previous version, while processes launched using 
Version 2015 authorize using a separate authorization file. 

If the file TNOCMD.OK is stored in the root directory, Telewindows checks whether 
the authorization file name specified as v11-ok-file-path is listed in TNOCMD.OK. 
Telewindows loads the file only if it is listed there. The root directory is the 
directory / on UNIX platforms or the directory \ on Windows platforms.) 

On Windows platforms, you can specify a UNC network path as the v11-ok-file-
path, such as \\my-server\my-dir\.
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Special Considerations 

You can also use the -ok command-line option, the TW_OK environment variable, 
and the tw.ok file to specify the location of the authorization file. The order of 
precedence for identifying the authorization file to use is:

1 The -v11ok command-line option.

2 The -ok command line arg.

3 The TWV11_OK environment variable.

4 The G2_OK environment variable.

5 A file named twv11.ok in the G2 home directory.

6 A file named g2.ok in the G2 home directory.

For more information, see ok.

Example 

On a Windows platform, this command starts a new process and identifies 
c:\Program Files\Gensym\g2-2015\g2\my-g2.ok as the Version 2015 
authorization file: 

tw sitenode 1311 -v11ok "c:\Program Files\Gensym\g2-2015\g2\my-
g2.ok"

On a UNIX platform, this command starts a new process and identifies 
/usr/gensym/g2-2015/g2/my.ok as the Version 2015 authorization file: 

tw sitenode 1311 -v11ok /usr/gensym/g2-2015/g2/my-g2.ok 
180



verbose
verbose
Prints information about the current G2 to the console or log file, such as the 
location of the G2 OK file. 

Platforms 

All platforms 

Syntax 

-verbose

Equivalent Environment Variable 

None 

Description 

Example 

tw sitenode 1311 -verbose
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width
Specifies the width in pixels of the window. 

Platforms 

All platforms 

Syntax 

-width number-of-pixels 

number-of-pixels: A positive integer from 1 to 32,767.

Equivalent Environment Variable 

None 

Description 

This option specifies the width in pixels of your window, which is stored in the 
g2-window-width attribute of the g2-window.

By default, Telewindows displays a window whose width is 90% of the height of 
the screen. 

On Windows platforms, the width refers to the entire window, including the title 
bar and the black frame around the window. On UNIX platforms, the width refers 
to the client window area only; it does not include the width of the title bar and 
window frame.

Example 

This command starts a process with a window whose width in pixels is 1000 and 
whose height in pixels is equivalent to 90% of the height of the screen, the default: 

tw sitenode 1311 -width 1000 
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window
window
Specifies the window name or class of g2-window that a target secure G2 
associates with a Telewindows window. 

Platforms 

All platforms 

Syntax 

-window window-name-or-class 

window-name-or-class: Name or class of a g2-window item or of an item whose 
class is a subclass of g2-window. 

Equivalent Environment Variable 

None 

Description 

Specifying the -window option corresponds to the G2 Window Name or Class 
field in the login dialog.

Examples 

This command starts a new Telewindows process that connects to a secure G2, 
specifying a window and other information necessary to connect to the process: 

tw sitenode 1311 -window viper -user-name howard 
-password fearnoevil -user-mode manager -language korean
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window-style
Specifies the window style that Telewindows uses.

Platforms 

All platforms 

Syntax 

-window-style {default | standard-large | g2-5.x | standard}

Equivalent Environment Variable 

None 

Description 

This command-line option allows you to choose a larger version of the standard 
window style or the traditional G2 window style. By default, uses the standard 
window style in which workspaces have editable title bars and close buttons. 
Specifying default as the window style is the same as specifying standard.

For examples of each of these window styles, see “G2 Window Styles” in 
Chapter 2 “The Developers Environment” in the G2 Reference Manual.

Example 

This command starts a Telewindows process, using a larger version of the 
standard window style:

tw sitenode 1311 -window-style standard-large
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x-magnification and y-magnification
x-magnification and y-magnification 
Specifies the window’s default ratio of horizontal (x-axis) or vertical (y-axis) 
magnification, in pixels per G2 workspace unit, for workspaces displayed at 
full scale. 

Platforms 

All platforms 

Syntax 

-x-mag[nification] magnification-ratio 
-y-mag[nification] magnification-ratio 

magnification-ratio: A decimal value from 0.50 to 2.66.

Equivalent Environment Variable 

None 

Description 

For a display device that supports distinct settings for vertical and horizontal 
resolutions, you can use the -x-magnification and -y-magnification options 
to specify distinct horizontal and vertical magnifications. 

These options specify the ratio of pixels per workspace unit at which the new 
window displays workspaces. For either option, specify a decimal value in the 
range 0.50 to 2.66. 

If you do not specify the -x-magnification or -y-magnification options or the 
-magnification option, the new window uses a -magnification setting of 1.0; 
this is equivalent to a -x-magnification setting of 1.0 and a -y-magnification 
setting of 1.0. 

By specifying different combinations of -x-magnification and 
-y-magnification settings, you can display workspaces in the process’s window 
at an effectively equivalent absolute size on different display devices. 

For more information about using the -magnification, -x-magnification, and 
-y-magnification options, see Specifying the Resolution and Magnification. 
185



Special Considerations 

Alternatively, you can use the -magnification option to specify the same setting 
for both the horizontal and vertical axes. However, do not combine the 
-magnification argument with either the -x-magnification or 
-y-magnification options. See magnification.

Example 

This command starts a process whose window displays full-scale workspaces 
with a horizontal magnification of two pixels per G2 workspace unit and with a 
vertical magnification of one and a half pixels per G2 workspace unit: 

tw sitenode 1311 -x-magnification 2.0 -y-magnification 1.5 
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x-resolution and y-resolution
x-resolution and y-resolution
Specifies the horizontal (x-axis) and vertical (y-axis) resolution of the monitor on 
which a window appears. 

Platforms 

All platforms 

Syntax 

-x-res[olution] dots-per-inch 
-y-res[olution] dots-per-inch 

dots-per-inch: An integer in the range 36 to 200. 

Equivalent Environment Variable 

None 

Description 

For a display device that supports distinct settings for its horizontal and vertical 
resolution, you can use the -x-resolution and -y-resolution options to specify 
separate default horizontal and vertical resolutions. 

These options specify the resolution as the number of dots per inch (dpi). By 
default, displays a window at a default resolution of 75 dpi. 

These values are stored in the g2-window-x-resolution and g2-window-y-resolution 
attributes of the g2-window.

By specifying different combinations of -x-resolution and -y-resolution 
settings, you can display workspaces on a window at an effectively equivalent 
absolute size on different display devices. 

For more on the -resolution, -x-resolution, and -y-resolution options, see 
Specifying the Resolution and Magnification.

Special Considerations 

Alternatively, you can use the -resolution option to specify the same setting for 
both the horizontal and vertical axes. However, do not combine the -resolution 
option with either the -x-resolution or -y-resolution options. See 
resolution.
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Example 

This command line starts a process that displays its window at a horizontal 
resolution of 150 dpi, and a vertical resolution of 175 dpi: 

tw sitenode 1311 -x-resolution 150 -y-resolution 175 
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Glossary
A B C D E F G H I J K L M
N O P Q R S T U V W X Y Z
A

allocation message: A message that Telewindows prints on the console when it 
allocates more memory during KB loading or execution. 

allocation report: An allocation table or message. 

allocation table: A table that Telewindows prints on the console when it starts up. 
The table describes memory requirements, defaults, requests, and initial 
allocations. 

argument: A value or item that is passed to an invoked procedure or function. 

attribute: A characteristic or property of an item (any object, connection, 
workspace, and so on) in a G2 knowledge base. An item’s set of attributes is 
defined by the item’s class. 

attribute table: A two-column table that shows the name and value of each 
attribute of an item. 

authorization file: Also known as the tw.ok file. This file identifies each 
authorized user and optionally associates each user name with a user mode. 

authorization level: A method for managing G2 license options with Gensym’s 
Telewindows license options. 

B

background: In your Telewindows’s window, the visible pattern upon which 
Telewindows displays the current KB’s workspaces. (Clicking the mouse on this 
background displays the Main Menu.) In a workspace, the visible color or image 
upon which the workspace’s items appear to reside. (Clicking the mouse on this 
background displays the KB Workspace menu.) 

C

class: A group of items that have the same icon, attributes, and behavior. Classes 
are organized into a hierarchy, in which each class inherits the attributes of its 
superior class, but may have additional attributes of its own. 

class hierarchy: A hierarchical structure of class definitions that is built into G2, 
but can be extended by the user. 
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class-specific attribute: An attribute that is specified by a class’s definition, rather 
than inherited from the definitions of its superior classes. 

classic user interface: The user interface provided for backward compatibility. 
Classic Telewindows always uses a single G2 window for displaying workspaces. 
It has no developer menu bar, classic G2 popup menus, classic dialogs, and G2 6.x 
mouse gestures, key bindings, and shortcut keys, with no selection.

color attribute: A named portion of an item’s knowledge that can have a color 
value, such as the background-color color attribute of workspaces. Color 
attributes do not appear in the attribute tables of items. 

command-line option: Included in the operating system command that launches 
a new Telewindows process, this keyword affects how the new Telewindows 
starts and runs. 

configuration: A declaration that changes the default behavior of items. 

current KB: The items contained in the memory of a running G2 process. 

current language: An existing language translation item (or the symbol english) 
that G2 uses to display the names of menus and menu choice text (and for some 
languages, a custom Text Editor interface) in the G2 developer’s environment. 
Contrast with default language. 

current scale: For a workspace, the scale at which Telewindows displays that 
workspace, which is a factor of its default scale. By specifying a new current scale, 
you can interactively or programmatically change the displayed size of a 
workspace. Contrast with default scale. 

D

dedicated license: One type of G2 license for Telewindows. In a dedicated 
Telewindows environment, each license is authorized for a specific level of access 
to the server. 

default language: The language translation item (or the symbol english) that 
Telewindows uses to display the names of menus and menu choice text (and for 
some languages, a custom Text Editor interface) in the G2 developer’s 
environment. Contrast with current language. 

default scale: By default, a new workspace’s current scale is the normalized scale 
for the Telewindows process, which Telewindows determines by calculating the 
ratio of workspace units per pixel of resolution on your computer’s display 
device. 

developer menu bar: On Windows platforms, the default menu bar that appears 
when you launch Telewindows, using its standard user interface. The developer 
menu bar provides all the menu choices developers need to build and run G2 
applications.
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direct superior class: The class or classes from which a class inherits directly. 
A class also inherits indirectly from all the superior classes of its direct superior 
class or classes. 

E

error condition: An unexpected discrepancy that occurs while G2 is handling 
information. 

error handler: The portion of an application that responds to error conditions. 
G2 provides a default error handler, which responds to an error condition by 
placing a message on the Operator Logbook. You can write a custom error 
handler in a G2 procedure by coding an on error statement whose block of 
statements respond to error conditions that arise within that procedure. 

event: A system-defined occurrence. The antecedent of a whenever rule can refer 
to events. 

expression: A phrase that G2 evaluates to produce a value or a reference to an 
item. 

extent: The visible, rectangular portion of a workspace’s region. Also, the visible, 
rectangular region within which Telewindows displays an item’s representation. 

F

floating license: One type of G2 license for Gensym’s Telewindows product. 
Floating Telewindows licenses are G2-server based; that is, the G2 license 
includes a finite number of floating Telewindows connections. 

G

G2 GUIDE: See GUIDE. 

Gensym character set: The characters that are valid to specify in a symbol or text 
value in G2. G2 provides facilities for its Text Editor that allow you to enter any 
character in the Gensym character set. When inputting or outputting symbol and 
text values, G2 also observes rules for translating those values to and from the 
character codes of standard character sets. 

GUIDE: A Gensym product, also known as G2 GUIDE. A knowledge base that 
allows you interactively to create the user-interface components for a G2-based 
application. Objects created using GUIDE are a permanent part of your 
knowledge base. 
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H

hierarchy of classes: An organization of classes into superior and subclasses to 
allow for inheritance of attributes and other knowledge. Each class inherits the 
attributes of its superior classes. 

I

icon: The graphic representation of objects and items of other system-classes with 
an iconic representation style. In G2, items of many system-defined classes appear 
as icons. Use the Icon Editor to define the icon for user-defined classes. 

ICP (Intelligent Communications Protocol): Gensym’s proprietary 
communications protocol, which allows G2s, GSIs, and Telewindows to share 
information and distribute control among one or more G2 processes. ICP is a 
layer built on top of the TCP/IP networking protocols, depending on which 
platforms you are using in your network. 

image: A bitmap or other graphical image created outside G2. You can use an 
external image as part of an icon, or as the background of a workspace. 

inference engine: The G2 component that monitors events and reasons about 
changing conditions while invoking rules by means of forward chaining, 
backward chaining, event detection, focusing, and scanning. 

inheritance: An important property of object-oriented development 
environments. A class inherits the attributes of its superior. Inheritance facilitates 
rapid development, eliminates redundancy in an application, and builds reusable 
application components. 

inherited attributes: Attributes that a class has by inheriting them, rather than by 
defining them in the class’s definition. 

installed system tables: The system tables whose values are in effect for the 
current KB. In a modularized KB, there are as many sets of system tables as there 
are modules; however, only one set of system tables is installed at a time. 

instance: One of a class of items, for example, pump-1 is instance of the PUMP 
class. 

Intelligent Communications Protocol: See ICP. 

item: An entity in G2 that represents a set of knowledge that has identity and that 
persists. Each item represents a set of information that is distinct from other 
information and that you can reference directly or indirectly. 

item layering: Whether items upon the same workspace appear on top of or 
beneath each other. 
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K

KB: See knowledge base. 

KB file: The file that G2 writes when you save the current KB. This file contains 
only ASCII characters, and thus is portable to any G2 of a compatible version or 
earlier that runs on any supported platform. By default, a KB file’s name has the 
extension .kb. 

KB workspace: An item of the KB-WORKSPACE class, which is the only kind of 
workspace in G2 that the current KB can work with programmatically. Contrast 
with workspace. 

keystroke: Pressing a key on your computer’s keyboard, or pressing at the same 
time more than one key on your computer’s keyboard that includes any 
combination of the Alt, Control, and Shift keys. 

knowledge base: A set of items that is either contained in G2’s memory (the 
current KB) or stored in a KB file. 

L

literal value: In an expression, a series of characters that literally signifies a value 
of type integer, float, truth-value, text, or symbol. 

local window: The visible window that is a client of a G2 process. Among 
computers running the X Windows window manager, a G2 process’s local 
window can be displayed either on the screen of the computer where G2 is 
running or on another computer’s screen. Contrast with remote window. 

log file: A file to which G2 can optionally write informational messages. 

M

margin: The distance in workspace units between the outermost items upon a 
workspace and the workspace’s border. Each workspace’s margins are 
automatically maintained by G2. Set the default margin for all new workspaces in 
the Miscellaneous Parameters system table. 

memory leak: A loss of usable storage space caused by the application’s failure to 
correctly reclaim the memory occupied by the current KB’s transient items. 

menu: A list of choices that Telewindows displays when you click the mouse on 
the Telewindows window’s background or on an item. Selecting some menu 
choices causes Telewindows to display another menu, called a submenu. 

Message Board: A named KB workspace that can be the destination of messages 
from an inform action. 

metacharacters: Special characters that let you specify a wildcarded name 
expression. For example, the * (asterisk) matches zero or more characters. 
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mouse click: The act of pressing and releasing any button on the hand-held 
mouse. 

N

Native Menu System (NMS): A set of tools for creating standard end-user 
interfaces for G2 applications when viewed through Telewindows. These tools 
allow you to create custom pulldown menus and popup menus, using one of two 
techniques. You can use the G2 Menu System (GMS) to create custom menus, 
using a graphical user interface, which automatically render as native Windows 
menus when viewed through Telewindows. You can also use the NMS API to 
create and manipulate Windows menus, using G2 system procedures. 

natural language prompts: In the Text Editor, the prompts that G2 displays 
below the edit area to guide you through the statement syntax and available 
options. 

normalized scale: The ratio of workspace units per pixel for a Telewindows 
process. By default, the current scale of a new workspace is this Telewindows’s 
normalized scale. 

O

object: An abstract or concrete thing of interest in your application, such as a 
product, space station, bottle, event, or workstation. Every object has an attribute 
table, and may have an icon and connection stubs. Every object is an instance of a 
class, which is defined through an object class definition. 

Off-line license: A fundamental G2 license type providing G2 for a stand-alone 
system. 

On-line license: A fundamental G2 license type providing the capability to 
communicate or access other systems. 

Operator Logbook: A special workspace for displaying informational messages 
and signalling G2 errors. You control the placement and other properties of the 
logbook workspaces using the Logbook Parameters system table. 

P

palette: A menu that presents G2’s default colors. Also, a workspace that contains 
each type of object that you can create in a knowledge base. You can create new 
objects by cloning from the palette. 

platform: A combination of a brand of computer and a brand of operating system. 
Telewindows runs on several UNIX and Windows platforms. 

protocol: A specification of the format and content of information sent between 
one process and another, such as between G2 and Telewindows. 
194



Q

qualified filename: A filename that includes an extension. 

R

Region 1: A block of memory used by Telewindows to hold items and non-
symbolic values.

Region 2: A block of memory used by Telewindows to hold symbols and related 
internal data. 

Region 3: A block of memory used by Telewindows to hold any external images 
used in icons and as the backgrounds of workspaces. 

remote window: The visible window that is a client of a Telewindows process 
connected to a running G2 process. Contrast with local window. 

reserved symbol: A symbol that cannot serve as a user-defined name in G2. In the 
Text Editor, the prompt any unreserved-symbol indicates where you must enter a 
user-defined name. 

run-state: Whether the connected G2’s KB is running, paused, or reset. Changing 
the KB’s run-state affects the KB’s knowledge. 

running G2: A G2 process that resides in the computer’s memory and whose 
execution is not currently suspended by the computer’s operating system. It does 
not matter whether the G2’s current KB is running, paused, or reset. 

S

schematic: A picture of the application; consists of objects and their connections.

secure G2: A G2 process that requires its users to log in. If the installed G2 
product has a valid license, then from that licensed image you run a secure G2 by 
creating an authorization file (the g2.ok file) and including it in user items that 
authorize each user of this G2’s KB. 

shrink wrapping: For a workspace, the operation of decreasing its extent by 
moving its borders inward; after shrink wrapping, the workspace’s borders are 
just outside the workspace’s items that are farthest apart vertically and 
horizontally. 

standard output messages: A report of the initial allocations for Telewindows’s 
memory regions and network port numbers. As a new Telewindows process 
starts up, it displays standard output messages. A Telewindows process also 
produces standard output messages when it must attempt to allocate additional 
memory allocations and when it detects an internal error. 

standard user interface: The default user interface style for Telewindows, which 
provides various standard Windows user-interface controls, including a 
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developer menu bar, popup menus, and certain standard dialogs. In addition, can 
workspaces appear in their own window with scrollbars. The standard user 
interface is selection-style, whereby menu choices apply to the currently selected 
object. The user interface also uses standard mouse gestures, key bindings, and 
shortcut keys. 

subclass: A class subordinate to another in the hierarchy of classes. A class can 
have any number of subclasses. 

superior class: A class that is at a higher level than another in the hierarchy of 
classes. Classes inherit attributes from their superiors. 

T

table: See attribute table. 

TCP/IP: A transport layer protocol for communications between computers. 
TCP/IP is one of two communication protocols supported by G2 and related 
Gensym products. 

Telewindows: A Gensym product. When running, allows a user to connect to a 
running G2 process and view a window that displays the contents of the G2’s 
current KB. Multiple Telewindows users can access one G2. 

title block: The workspace that G2 displays at start-up in its local window. The 
title block reports: the G2 version, the platform, network ID (or hostname) of this 
computer, and the TCP/IP port number on which this process listens for network 
connections. 

U

unqualified filename: A filename without an extension. 

user mode: A non-reserved symbol that represents a category of usage or level of 
access to the current KB’s knowledge. Declare a user mode simply by naming it in 
at least one configuration statement in at least one item in your KB. A G2 
authorization file associates each authorized user name with a user mode. 

V

value: A number, series of characters, or truth-value that conforms to the 
definition of a type. 

W

warmboot: The activity of resuming execution of the current KB after loading its 
knowledge from a snapshot file. 
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wildcard: When specifying an operating system directory to search or a KB file to 
load or merge, use a wildcard, or reserved character, to signify one or more other 
characters in a specified directory name and/or filename. G2 uses wildcard 
characters and conventions that are independent of the operating systems of the 
platforms on which G2 runs. 

window: A display on a computer screen that is a client of a process, such as G2 
or Telewindows. A window’s user interface (for example, whether and how it can 
be moved, resized, or iconized) is determined by the window manager software 
in use on your computer. 

workspace: An item in G2 that organizes a set of items within an abstract, three-
dimensional region. A workspace appears in a G2 window or Telewindows 
window as a bounded rectangle. A workspace both contains items and arranges 
them schematically with respect to each other. A workspace can be the inferior 
item of another item; thus, your KB can contain a hierarchy of workspaces. 
Contrast with KB workspace. 

workspace unit: A unit of measure within a workspace that is equivalent to one 
pixel (one screen dot) when the workspace is shown at full size, which is 
proportionately larger or smaller as the workspace’s scale is increased or 
decreased, respectively. 

workspace view: A subclass of g2-window. When viewed through Telewindows, 
a workspace view appears in its own window with scrollbars, as needed, as the 
window and/or workspace size changes. You use standard scrollbars, mouse 
gestures, and shortcut keys to scroll a workspace view. 
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popup menus

standard
for items
for KBs
for selections
for workspaces

prefer-native-editor attribute
Print menu choice
Print to Server menu choice
Print Window menu choice
printing

Telewindows from Netscape
to printers on the client

private colormap
advantages
disadvantages

-private-colormap command-line option
using

prompts
controlling

grammar prompts that appear in Text 
Editor

properties
workspace view control

properties, Telewindows
ActiveX control

Q
quitting

Telewindows

R
registering

G2Com DLL
WorkspaceView control

registering Telewindows ActiveX control



from a URL
initially
manually

registerTwControl.bat
registerWSV.bat

-regserver command-line option
using

remote windows
rerouting Telewindows connection
-resolution command line option

description of
-resolution command-line option

using
resolution of monitor

for Telewindows window
specifying horizontal and vertical axes

-rgn1lmt command-line option
using

-rgn2lmt command-line option
using

-rgn3lmt command-line option
using

run state
controlling

runme.bat

S
saving KBs
-screenlock command-line option
scrolling workspaces

standard keybindings for
when resizing windows
when showing initially

-secure command-line option
secure G2
selections

working with
ShowWorkspaceWithName method
ShowWorkspaceWithUUID method
Shut Down G2 menu choice
Site Map dialog

of twtour.kb sample KB
site-map.txt file
-splashtime command-line option
Splashtime property
standard output messages

not writing to log file by using -no-log 
command-line option

of Telewindows process
writing to log file by using -log command-
line option

standard Telewindows
standard user interface

overview
starting

G2
standard

Telewindows
standard

switching Telewindows connection
See rerouting Telewindows connection

system procedures
workspace view control

system tables

T
TCP/IP ports

specifying number in site-map.txt file
time interval for connecting to

specifying by using -tcptimeout 
command-line option

TCP/IP protocol
network connection via
specifying by using -network command-

line option
specifying timeout interval for

-tcptimeout command-line option
Telewindows

access limit for floating licenses
ActiveX control

classic
code for installing
default G2 window
environment variable for
HTML page examples
methods
overview
properties
registering
registering from a URL
registering manually
specifying location of executable
specifying location of executable, 

example
unregistering
using in Internet Explorer
Visual Basic example

authorization file for
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authorization levels for
client in client-server relationship to G2
command line options for

using to login
command-line options for

specifying
compatibility of licenses
connecting to local or remote G2
correcting an incorrect login
dedicated licenses
disconnecting workspace view control
entering a user mode
entering a user name
entering a window name or class
entering a window-specific language
entering the command line
executables
exiting
floating licenses
interacting

with items
with KBs
with selections
with workspaces

introduction
licensing for
location of authorization file
logging in

to a secure G2
using the G2 Login dialog

logging out of a secure G2
management of communications with G2
Netscape Navigator plugin support
Next Generation
reasons for using
rerouting
shutting down
standard
standard output messages
standard user interface demo
starting

standard
to establish connection to a G2

starting on Windows platforms
starting via operating system command
using
using backing-store facility

Text Editor
controlling

grammar prompts that appear
text editor
204
classic
displaying

using a menu choice
standard Windows

for editing G2 text
text editor, standard Windows

keyboard shortcuts
title bar text

specifying on command line
tnocmd.ok file

location of
using the -ok option
using the -v8ok option

Tools menu
TW_HOME_FOR_ACTIVEX environment variable
TW_OK environment variable
tw.exe

tw.ok file
TwControl.cab
TwControl.ocx

TwLocation property
twng.exe
twtour.kb

running
setting up

TWV8_OK environment variable

U
-ui command-line option
unregistering Telewindows ActiveX control
unregistering WorkspaceView control
unregisterTwControl.bat
unregisterWSV.bat

-unregserver command-line option
using

user interface
setting when starting Telewindows

user interface mode, controlling
User menu
user menu choices
user modes

entering via the G2 Login dialog
logging into a secure G2 process

user names
configuring

using command-line option
entering via the G2 Login dialog

-user-mode command-line option
corresponding to G2 User Mode field
description of

-user-name command-line option



corresponding to User field
description of

V
-verbose command-line option
version, specifying for ActiveX control

W
-width command-line option
window classes

entering via the G2 Login dialog
-window command-line option

corresponding to G2 Window field
Window menu, using
window names

entering via the G2 Login dialog
for logging into a G2 process

window styles
for logging into a G2 process

windows
cached

on X-server
updating from backing-store

displaying on X Windows servers
for a G2 process
for a Telewindows process
G2? capabilities to differentiate
local
option

for specifying magnification
for specifying resolution

remote
specifying

full-screen
geometry
height
initialization string for
title bar text

specifying dimensions
with -magnification option

specifying magnification
with -magnification option
with -x-magnification and -y-
magnification options

specifying resolution
with -resolution option
with x-resolution and y-resolution 

options
Windows dialog
of twtour.kb sample KB

window-specific language
entering via the G2 Login dialog

-window-style command-line option
workspace view control

environment variable for
introduction to
methods
properties
registering

G2Com DLL
WorkspaceView

sample HTML page
sample Visual Basic form
specifying location of executable
system procedures

WorkspaceName property
workspaces

changing the layering of
creating
creating items on
default behavior

using standard user interface
display of

G2? capabilities to differentiate
schematic diagram of

displaying using Window menu
interacting with
key bindings for scrolling
printing to printer on the client
resizing windows
same contents displayed in different 

windows
scaling
scrolling
showing

WorkspaceUUID property
WorkspaceView.ocx
WorkspaceViewDemo.exe
WorkspaceViewDemo.vbp
wsvdemo.kb
wsview.html

X
X Windows servers

displaying window on
specifying window geometry on
using for backing-store facility

-x-magnification command line option
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description of
-x-magnification command-line option
-x-resolution command line option

description of
-x-resolution command-line option

using

Y
-y-magnification command line option

description of
-y-magnification command-line option
-y-resolution command line option

description of
-y-resolution command-line option

using
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